United States-English

» Contact HP

Phone orders 1-877-801-7183

Search:

n Home & Home Office m
i
j
k
l
m
n All of HP United States
j
k
l

Lessons - Web site basics
» Home & Home Office
Hello, Truitt
» Edit profile
» Sign out
» Online classes
» Your classes
» Contact us
» FAQ
» Digital Photography
» Everyday Printing
» Everyday Computing
» Digital Entertainment
» Activity Center
Browse & Buy
» Home & Home Office
Store
» Rebate Center
Product Support
» Support &
troubleshooting
» Software & Drivers
» Warranties & services
» Register your product

View your shopping cart
Web site basics
» Lessons
» Message board
» Class materials

Lesson 1

Welcome to your lessons. Some lessons may have quizzes or
assignments for additional learning. Don't forget to join your fellow
classmates and instructor on the message board.
» View single page

A page to call home
No Web site I've built could ever compare to my first: the "Delete Jar Jar Binks" home page. Soon
after seeing Star Wars Episode One: The Phantom Menace on opening night with a bunch of people
dressed like Jedis, I channeled my rage at the movie's animated star into a screed that I posted on
the Web. Within hours, responses came pouring in. Some readers vehemently agreed with me, some
vehemently disagreed, most told me to get a life. I found that my little joke (okay, I wasn't completely
joking) touched a nerve with people, putting me in the midst of one of those Internet phenomena I
had always read about but never truly participated in. For months and even a few years afterward, I
still got e-mails about Jar Jar Binks. That's the power of the Web, and the thrill of publishing a Web
site. You never know what sort of response you might get.
Why do you want to build a Web site? Why not? These days, having a Web site is one of those
essentials in life you could do without, but wouldn't want to, like microwaves or reality television.
Having a Web site is a great way to impart information cheaply, no matter if you want to promote your
business, display a family album, express yourself in a new way or just keep up with the Joneses in
your virtual neighborhood.
In this course, we'll stick to the basic information you'll need to get a Web site up and running. We'll
discuss planning, preparing content, uploading the site, building in advanced features like multimedia
and e-commerce, and ways to draw bigger audiences.
Don't worry; we won't force you to learn all the fine details of HTML (Hypertext Markup Language)
coding. These days, you almost don't need to know anything about such Web building languages.
Instead, we'll concern ourselves with the preparation and execution behind getting and keeping a
Web site active.

If you get the hankering, HTML is fairly simple to learn. A quick hunt on a search engine like
Google will yield plenty of Web sites that offer free online tutorials spanning the basics to
advanced programming.

Web sites: an introduction

So let's take it from the top. A Web site is a collection of Web pages. Every Web site has a home (or
index) page that links to other pages ranging from a few to hundreds. Even a single-paged site
requires careful thought and planning before it goes online.
Before we can go further, you need to ask yourself the following questions about your Web site:




Why are you creating this Web site? You could be writing about your hobby, posting your
company's press material, or showing off your kid, but the purpose of a Web site boils down to
the same thing: disseminating information. Before you can create a site, you must figure out
what you want to say and how you intend to say it. Search around the Web and see how other
people handle your idea. Even if someone's already approached the same terrain in a fancy
way, you'll want to stay simple for now, unless you have a dedicated staff of Web developers
at your disposal.
Who is your intended audience? Who's supposed to read your Web site affects its look,
tone, and usability. Generally, the broader your intended audience, the simpler your site and
its content should be. Figure 1-1 shows The Fortean Times Web site, who's audience is
people who like news of the weird.

Figure 1-1: The Fortean Times.
View a larger version of this image.



What words and images will you put on the Web site and how will visitors navigate
through them? You wouldn't want to post naughty limericks at a Web site for kids, or put a
full-size video file on a site your grandmother might access with her slow dial-up connection.
Think about who'll be reading the site and post your content accordingly.

Lines and circles

Now it's time to take concept to content: the words and images through which you convey your
message or sell your widgets.






Images: A newspaper page with no photos is called gray. A Web page with no photos is
called unreadable. The Web is as much a visible medium as a written one, and readers are
very likely to pass over pages without pictures. As you collect and scan images for your Web
site, be sure to use sharp and appropriate pictures, keeping their file size as small as possible
for faster downloading.
Text: A good photo speaks for itself, but without a caption, it says a lot less. More so than with
most forms of writing, the copy on your Web site should get to the point as soon as possible -even readers who surf for hours on end probably find it more comfortable to read on a paper
than a computer screen, so don't lose them with too much text.
Style: Then there's the matter of style. You may prefer an informal approach for your personal
Web site, but if you're pulling together a commercial or business-oriented site, keep the words
as concise, spell-checked, and grammatically correct as you would in a brochure.

Speaking of brochures, if you want to post already-existing company literature or any other
previously-written text but don't feel like entering it by hand, scan it in a scanner equipped with
OCR (optical character recognition), which converts published text into editable copy on your
computer.
Before considering what content to put on your Web site, research the competition. Taking a look at
other like-minded sites will give you ideas about what they don't have that your site could offer to set
it apart.
Say you're building a site devoted to breakfast cereals. You obviously want your site to be the best
source on the Web for information about cereal and/or cereal merchandise, but you won't know how
until you see what else is out there. Type breakfast cereals into Google . Of the sites returned, the
most intriguing entry appears about five sites down: The Empty Bowl , shown in Figure 1-2.
Following the link to Empty Bowl, you'll see that it's a well-developed "webzine devoted to serving the
cereal eating community."

Figure 1-2: The Empty Bowl, for all your cereal-eating needs.
View a larger version of this image.
You can't build a Web site like Empty Bowl overnight, with its archives of articles, surveys, discussion
board, reviews, links to other retail and nonretail sites. But you may notice that the site doesn't
actually sell cereal. Nor does it contain images of cereal boxes. Say, for that matter, it doesn't even
play a cereal theme song, like the Cocoa Puffs jingle.
You can either consider this an opportunity to add such features to your site, or look into possible
reasons Empty Bowl doesn't utilize them. Is it too much of a pain to set up a cereal store? Do cereal
boxes and their companion theme songs have copyright protection? It can't hurt to find out, especially
if it'll save you a lawsuit.
Remember that Web sites like The Empty Bowl are professional (or at least, semiprofessional in
this case) endeavors with dedicated staffs and designers. If you have none of these things, don't
despair -- on the Web, most visitors appreciate creativity and passion for a subject over flashy
graphics any day.

Up a tree
To save yourself lots of Edit > Undo-ing, draw a site map: an
organization tree that shows how each page on your Web site
links to each other. Although you may eventually want to post it on
your site, there's no need to get fancy with it for now. Sketch it on
a napkin if you like, just get your conception of the site's layout on
paper.

Why are you here?

There's nothing like peer
support in a learning
environment. If you ever
belonged to a study group in

But first, create a list of the separate pages you think you'll need
for your Web site. Once they're all down, group them together in
sections. Now you're ready to diagram. As your site's introduction,
table of contents, and gateway to other pages, the home page
deserves to be placed on top. Branch out from there, connecting
the pages as you intend them to flow on the site. Be prepared to
erase and redo links as many time as possible.

A corkboard with string and 3 x 5 cards works well for this
purpose. You can move the cards around until you get them
organized the way you want.
Later, when you build the Web site, your site map can serve as an
index of sorts to simplify navigation, as it does on Apple's site
(follow the link that says site map at the bottom of the page under
the search engine). Figure 1-3 shows the site map.

school, you'll remember the
value of putting heads
together to discuss the
subject and work through
solutions. The Message
Board is your online studygroup lounge, where you can
meet your classmates, share
your reasons for signing up
for this class, and talk about
your goals and dilemmas as
you work through this
course. You never know who
has the answers you seek.
Find the right PC for the job

» HP Pavilion desktop PCs
HP has a PC with the
features and price range to
meet your needs. Check out
the latest selection today.
HP Pavilion PCs provide the
versatile technology you
need to communicate,
create and enjoy your world
more.

Figure 1-3: The Apple.com site map.
View a larger version of this image.
Program that diagram

If you need help visualizing your Web site and paper's just not
cutting it, seek software help. You could either use the
diagramming functions in a professional program such as
Macromedia Dreamweaver , or search around on Download.com
for freeware and shareware applications like Custo 2.0 ($29 after

trial period) that do the same thing. Search for site map, to see
what all comes up. Figure 1-4 shows a site map in Microsoft's
FrontPage application.

Figure 1-4: A Web site map shown in Microsoft FrontPage.
View a larger version of this image.
Some software titles, such as FrontPage, create blank pages
as you add them to the Web site diagram to guarantee your
links lead to the right pages when your site is built.

Moving On

We've got the substance of your Web site down, now we'll move
on to an equally important component -- its style. In the next
lesson, you'll explore color and font schemes, how to use and
obtain artwork, and other design issues.
Before you go, take a few minutes to complete the assignment
and quiz. And feel free to peruse the Message Board and talk to
your fellow students.

Congratulations on completing the lesson! Don't forget the following:
» Assignment:Out of site, out of mind
» Quiz:Lesson 1, quiz 1
» Return to the lessons list to get a quick overview of the entire class
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Assignments are designed to help you apply the information learned in the lessons.
Out of site, out of mind
If you visited the Apple Web site map mentioned in the lesson, you may have noticed that
it doesn't in any way resemble the tree you've created for your own Web site. The map is a
very basic list of the content, broken into categories. It's the same idea as a tree, just
without the boxes and lines. Many Web sites use this format to outline content without
going into too much confusing detail.
For your assignment, browse the Web for more site maps, and see if you can find different
formats. Most Web sites place the links to their site maps at the bottom of the home page.
You have completed this assignment.
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Quiz: Lesson 1, quiz 1
Quizzes are designed to give you a chance to test your knowledge.
Please feel free to take this quiz again. We will update your score.

1. What's the first thing you should do when planning a Web site?
A.

Stock up on beer and pizza - it's going to be a long night.

B.

Find a spot where you think the spider can catch lots of bugs.

C.

Determine your purpose, intended audience, and site layout.

2. What's a site map?

B.

An organizational chart that shows each of the Web site's pages and how to reach
them.
A guide to buried treasure.

C.

A complete representation of your Web site's colors, fonts, and images.

A.

3. True or false: You must know HTML, and possibly other languages, before you can build a
Web site.
A.

True

B.

False
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Lesson 2

Welcome to your lessons. Some lessons may have quizzes or
assignments for additional learning. Don't forget to join your fellow
classmates and instructor on the message board.
» View single page

Design language
You've got the hook for your Web site, now you need the look. If you've never designed anything
before, don't worry: as long you keep things simple, Web design is hard to mess up if you just keep in
mind a few simple pointers about layout, colors, fonts, images, and accessibility. Maybe that sounds
more daunting than I intended, but it's not. Really.
Clean your template
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» Warranties & services
» Register your product

Web design starts with a template, the consistent look that runs throughout your Web site. By giving
each page a similar look, templates ease the task of generating new pages for the designer and help
viewers navigate a site by giving them familiar surroundings.
When making a template, creativity is all well and good, but it doesn't hold a card to usability, which
is the ease with which visitors move around your Web site. After all, getting around a site shouldn't be
a game of hide-and-seek. Even relatively new Web surfers expect to find certain elements in place,
such as introductory text and/or an image. Let's take a closer look at two other essentials: the
navigation bar and logo.




Navigation bar: An interactive table of contents, the navigation bar contains the links to each
section of your Web site. Generally, arranging it horizontally across the top or vertically along
the left works best, though some sites get away with placing it along the bottom, under a
central image, or down the right side. Some sites, mostly the info-heavy ones, use multiple
navigation bars on their home pages, but this approach is rarely necessary.
Logo: If it works for products, it will work for your Web site. Logos (or, on personal Web sites,
some sort of recurring image, title or theme) brand your site, making it familiar and
recognizable to users. Most sites place their logos on the top-left corner of each page, as

shown in Figure 2-1, a convention many users find familiar. Logos can also serve the helpful
function of linking to your home page so visitors never have to look hard to find their way
back.

Figure 2-1: The Onion keeps its simple navigation bar near its simple logo.
View a larger version of this image.

No matter how much you need to stray from the template, never alter the basic colors, fonts, and
logos you've used throughout the Web site. Ditching those will make readers felt they've entered
another site.

Exceptions to the rule

Although you should give most of your site the same skeleton, certain pages will require slightly
different looks to set them apart:





Home page: As your visitors' first impression of the Web site, this page should stick as closely
as possible to the template.
Commercial pages: Pages for an online store may stray a bit from the template to
accommodate multiple images or inventory-database output. To keep a potential buyer's focus
on buying, you can reduce the number of internal links that lead to other sections and
increase the links that will keep them shopping.
Feedback, shopping carts, and other forms: Don't bog down these types of pages with too
many links either. You'll want to keep users distraction-free so they'll buy stuff or enter the
desired information, which means sticking as closely to the template as possible.

Break the color barrier
Ever wonder whatever happened to the rainbow rule bars and hotpink type on fluorescent-green backgrounds of the Web's early
days? The answer is simple -- people got a clue that it looked
horrible. See Figure 2-2 to see what we're talking about. This Web
site from the Molehill Group actually tells you how to build
annoying Web pages.
The rules of color usage are many, but the primary (no pun
intended . . . okay, maybe it was intended) one you need to keep
in mind for Web design is this: busy colors schemes distract from
content. The Web may make it simpler than any medium to create
intricate explosions of color on a Web page, but that doesn't mean
you have to make them.

See each color clearly

»
HP vs17 17" flat-panel LCD
monitor
Make the most of today's
colorful multimedia with the
vs17 flat-panel monitor,
which provides up to 31.7%

more viewing area than the
15" HP vs15 monitor. The
vs17 has integrated
speakers, which means you
have two fewer things on
your desk. And since it's got
a detachable base, you can
even mount it on the wall.

Figure 2-2: Argh! Put out that Web site! My eyes are burning from
the color combo! Of course, that's the point this site is trying to
make.
Color me complementary

If a Web site is your virtual home on the Web (humor me here with
this metaphor), you'll want to paint it the way you would a house.
That means you don't just pick a color because it looks good in
the can; you consider what will go with the furniture and the color
in other rooms. Likewise, effective sites use colors that
complement each other or contrast in visually effective ways.
Certain colors work together, both in soothing harmonious ways
and in loud, attention-grabbing ways. Either approach can work
for you, depending on the personality of your Web site. Gardening
sites tend to use earthy tones geared to remind you of nature's
majesty, whereas kid sites often stick to loud primary colors to
draw the eye of the cereal-buzzed set. Sites loaded with color
photos and multihued advertising read more easily with subtle
template colors that don't get in the way. On the flip side, a dash
of bright color in the template can spruce up a text-heavy site with
few images.
You don't need to be a fashion expert on a makeover reality TV
show to figure out color schemes. Just pick up the old reliable
color wheel to see how colors relate to each other, as shown in
Figure 2-3.

Figure 2-3: Behold, the awesome power of the color wheel.

For a handy run-down on the ins and outs of this miracle
device, go to Skribbles (www.scribbleskidsart.com), an art
Web site for children.

Play it Web-safe

Web-safe colors (a.k.a., browser-safe palette ) were devised
back when the Web was new and monitors couldn't support more
than a few hundred colors. Today's monitors have advanced to
handle just about any color you throw at them, but it's best to stick
to the Web-safe colors for the sake of people surfing the Web on
cell phones and other low-resolution devices.
A tone to pick

Keeping in mind the message you want to convey with your Web
site, use the wheel to pick two main colors and a few compatible
accent colors for your template. If you're stumped, take a look at
one of these helpful sites:






The Online Color Schemer ; You pick a color, it offers up
16 others that complement it.
The Colormaker : Lets you goof around with different
background and text color combinations.
The Color Coordinator : Lets you pick up to four
complementary colors at once based on eight types of
schemes like split complementary and monochromatic.
The Color Specifier : If you feel tied down by the Web-safe

colors, sample the many exotic color options on this site.

Dabble with the template colors all you like, but don't forget
that when it comes to the text, black letters on a white or lightcolored background is the most readable.

Fonts of wisdom

Tempted to go hog wild with all the gothic script and comic book fonts on your computer? Hey, I've
been there; you're not alone. But I'm hear to tell you to put aside that temptation and follow these two
essential rules for fonts:




Readability, readability, readability: Okay, that's not a complete sentence, but you get the
idea. The fonts you use must be easy to read. Web users have even less patience for
typographical goofiness on the Web than they do in print. You can break other design rules,
but if you don't present clear, readable text, you could well lose your reader.
Stick to easy fonts: If users don't have your Web site's fonts installed on their computers, their
browsers will substitute them with a default like Times or Helvetica. The only way to guarantee
your site will accurately display an out-of-the-ordinary font is by making the text an image file.
The drawback with this approach is that too many images bog down the time it takes for your
site to download and it interferes with accessibility. It's easiest just to use the standard fonts
that come with your computer. Figure 2-4 shows some wacky fonts.

Figure 2-4: Tempted to use these wacky fonts for your sites? Resist! Resist!A few other design
pointers that may come in handy:





Avoid too much centered text: Make sure most of your text aligns left, the easiest format to
read.
Minimize italics and boldface: Too much of either of these formats get annoying fast.
Avoid lots of underlined text: Underlined text is typically reserved for hyperlinks on the Web
and it's distracting to read.
Can it with all-caps: Only capitalize every letter in a word or group of words if completely
necessary.

Be sure to check your Web site on more than one browser as you build it to ensure it looks the
similar in all browsers.

Feet don't fail me now

Like peanut butter and chocolate, serif fonts (those with extra decorative edges or feet , such as
Times and Palatino ) and sans-serif fonts (those with no extra decor, such as Helvetica and Arial )
go well together -- one for headlines and captions, the other for body copy. Often, headlines and
captions work best in sans-serif, and body text (especially when it runs long) usually comes off better
in a serif. There's no iron-clad rule about which type of font to use for which type of word, but using
both can make your Web site look a whole lot better. Figure 2-5 shows three common serif fonts.

Figure 2-5: Three common serif fonts.
Figure 2-6 shows three common sans-serif fonts.

Figure 2-6: Three common sans-serif fonts.

Be sure your headers and navigation bars are distinctive from your body text and captions. They
can be the same font, but you should make them stand out in some way, either by boosting the
size or changing the background color.

Say cheese
Yes, you could avoid messing with images altogether on your
Web site and stick to just text, just like you could ride a bike to
work or eat gruel for every meal. Before the Web, the Internet was
merely the text equivalent of a ham radio network of computer
professionals (note: I didn't say geeks ) trading messages back
and forth about the latest developments in the industry. The Web
revolutionized these proceedings by adding a visual component to
the Internet. If you don't take advantage of this evolutionary step,
your site could end up looking like a throwback.
Photo finish

You can use pictures that relate specifically to your Web site, or
those that just set a mood (as rich men with surfboards do in
financial services ads). Just use them.
Icon and I will

Icons, those little images that represent something (men and
woman cut-outs for public bathrooms, for instance) can also make
your Web site more engaging and easier to navigate. After all,
who doesn't recognize the question mark as a link to the help
page? Icons also help international visitors penetrate the
language barrier, or in the case of young children, the preliterate
barrier.
Web sites such as Travelocity and Nickelodeon , shown in Figure
2-7, put these little doohickeys to good use.

Figure 2-7: Nick.com lets preliterate visitors explore the site with

Use your own images

» HP Scanjet 4850 photo
scanner
What's the secret of
impressive scans? Great
dpi, for one thing. The
Scanjet 4850 has that in its
up to 4800 x 9600 dpi, plus
this powerhouse supplies
48-bit color. You also get
handy one-touch buttons, a
built-in adapter for scanning
35 mm slides and negatives,
and dust and scratch
removal.

images.
Straighten up and copyright

Remember those images you gathered in the first lesson? Well,
there may be a catch with some of them: they could be
copyrighted. The Web abounds with images that can be swiped
with a simple mouse click, and you should always assume they
belong to someone else and can't be reproduced without
permission. No need to worry though, you can secure permission
to use a protected image, find them for free, or create your own
(more about that on the next page).
Copyright applies to any published image or text automatically,
even before the owner applies for it. Though you may not see a
copyright symbol beside an image, always assume it's
copyrighted. If it turns out to belong to someone, using it will be a
violation of the law.
However, never assume an image is off limits just because it's
protected. Contact the owner of an image you feel you can't do
without and see if he or she will sell it to you. Sometimes, the
artist will even give it away in return for a photo credit.
The royalty-free route

Forgoing their right to royalties each time their work gets used,
artists, writers, composers, illustrators, and photographers may
opt to designate their creations royalty-free. This means you only
have to pay them for it once up front and never again. Just search
on the Web for royalty-free or copyright-free art, or peruse
Comstock or Clipart.com .

Beware those art-photo-and-icon-loaded CDs sold in computer
stores: some of the images will cost you a whole extra fee on
top of the price of the CD. Read the fine print first.

Free and cheesy

And then there's always the free stuff. Free icons, drawings and
photos are all over the Web and ripe for the (legal) taking. Your
word processor probably even comes with a clip art collection, just
as image-editing tools like PhotoShop include royalty-free photos
with the package. Figure 2-8 shows some of the clip art available
in Microsoft Word.

Figure 2-8: The wonderful world of the clip-art images in Microsoft
Word.
A word of warning: too much clip art can look overly amateur
(unless that's what you're intentionally going for).
Artistic discretion

Just because you've obtained a lot of cool or costly images
doesn't mean you have to flaunt them. The best-designed Web
sites never overload a page with pictures; they give readers' eyes
a break by breaking text up with pictures and white space (empty
areas) to keep the message from getting lost in the clutter.
Also bear in mind the quality as well as the quantity of your
images. Good-quality photographs present a more professional
look, good for selling products or just letting folks know you're
serious. Illustrations can be dicier -- they've got to look pretty darn
good to compete with the professionalism of a photo, but even the
most amateurish scrawl can add a lot of fun to the casual Web
site.
How you mix and match photo and nonphoto images on your Web
site is up to you . . . and your download time. Clog a Web page
with too many large-size photos that take forever to load and
people aren't going to wait around to see them finally appear.

Let's play starving artist
When seeking out the images of others proves fruitless or just
plain bothersome, you've got another option. Make your own.

Choose the right camera

Snap to it

Digital cameras make photography a lot simpler by doing away
with film and showing instant result on built-in view screens. Even
better, many of these cameras import recent photos directly into
an image manipulation program or layout application.

Always shoot at the highest resolution allowed by your digital
camera. Although large, the file will have better quality, making
it more malleable when you tinker with its look and size before
placing it on the Web.

If you don't plan on giving up your film camera any time soon, no
problem. Most film developers will digitize your pictures and send
them back to you via e-mail, a CD-ROM, or through a photo
downloading service such as Snapfish , shown in Figure 2-9, or
Ofoto .

Figure 2-9: Instead of buying a digital photo, let your photo
developer send them to you via Snapfish.

» HP Photosmart M527
digital camera
A 2" display on the back and
designer editing tools lead
off the Photosmart M527's
list of coolest features. See
and edit photos
exceptionally clearly on the
spacious display. Apply
creative effects such as
"slimming down" pictures of
friends and adding borders.
Who knew a camera could
supply so much fun . . . not
to mention take such good
photos?

View a larger version of this image.
Win, lose, or draw

You can also render your own illustrations by hand (and scan
them in), or with the aid of an application. Microsoft Paint comes
free with Windows, whereas the more upscale Adobe Illustrator
and Macromedia Freehand offer trial periods before you decide to
buy.

If your photo skills or graphics art abilities leave something to
be desired, hire someone to do it. Any graphic designers who
may possibly be on your employ will likely be able to help you
in this area or know someone who can.

Usability and accessibility
Form does indeed follow function. A Web site that confuses
people is not well designed, no matter how good it looks. To this
end, certain rules and procedures for producing friendlier Web
sites have become the standards of usability and accessibility .

Get connected

Use it or lose it

Whether they realize it or not, everyone follows certain patterns
when they visit a Web site for the first time -- their eyes start in the
top-left corner of the Web page, they look at the pictures first, they
save the text for last. Knowing some of these tendencies will help
ensure your reader will react to your site the way you desire. Here
are a few rules to follow:






Use simple speak: So you want to make a cute navigator
bar with funny terms like Launch Pad in lieu of Home and
Guilty as Charged instead of Bio huh? I fear the laughs
will be on you when visitors leave in droves because they
can't figure out how to get around your Web site.
Color me easy to navigate: Web sites with lots of
categories should take a cue from parking garages and
assign each section with different colors. Knowing News is
red and Store is green helps visitors remember where to
go.
Say it in black and white: As I mentioned earlier, black
text on a white background is the way to go when it comes
to ease of reading. Put colored text on a colored
background and you're pushing it, especially if color-blind
visitors happen upon your Web site. Still, you can pursue
other alternatives that bend these rules, like using a very
light background with black text, or white text on a black

» Wireless network cards
An HP notebook with a
wireless network card allows
you to work from anywhere
that has wireless access.
Wireless cards are the key
to your computing freedom.

background. San-serif fonts usually work best for such
color combinations, especially if you've boosted their size.
The Web sites below mention more usability tips:




Usability First
UseIt
WebWord

Access divine

Architects and contractors have to keep people with disabilities in
mind when making a building; so do you when making a Web site.
The disabled use special tools to navigate the Web that the best
sites accommodate.
For example, alt-text, those pop-up captions that appear over
icons when a mouse pointer rolls over them. They aren't just for
show: text reader applications read those words aloud to describe
a Web site to a disabled person. Be sure to put text or alt-text in
your navigation bar and wherever else you may use an image to
represent a link.

To insert alt-text you simply use the alt attribute with the
<img> tag in HTML. Here's an example: <img
src="home.jpg" alt="Home"> .

For more on accessibility, visit these Web sites:




Web Accessibility Initiative
IBM Accessibility Center
Knowbility Curriculum

Moving on

In this lesson, you learned the basics of color, images, and fonts
for your Web site. Enough with the preliminaries already, let's get
out of here and learn how to actually build your Web site. But first,
please take a look at the assignment, quiz, and the latest celebrity
gossip (just kidding) on the Message Board.

Congratulations on completing the lesson! Don't forget the following:
» Assignment:Leaving the gate
» Quiz:Lesson 2, quiz 1
» Return to the lessons list to get a quick overview of the entire class
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A page to call home assignment
» Home & Home Office
Hello, Truitt
» Edit profile
» Sign out
» Online classes
» Your classes
» Contact us
» FAQ
» Digital Photography
» Everyday Printing
» Everyday Computing
» Digital Entertainment
» Activity Center

View your shopping cart
Assignments are designed to help you apply the information learned in the lessons.
Leaving the gate
Try out different color schemes at some of the color sites mentioned in this lesson,
choosing two main colors and one accent color.
Now pick the fonts you'd like to use. For ideas, load some of your favorite Web sites (or
your competitors Web sites as the case may be), view their source code ( View > Source
Code in most browsers), and take a look at their <font> tags. Note that when fonts are
designated, they usually include alternate choices like <font="Times, Arial"> .
Finally, choose photos and other graphics by searching some of the sources mentioned in
this lesson.
You have completed this assignment.

Browse & Buy
» Home & Home Office
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» Rebate Center
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» Support &
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» Warranties & services
» Register your product
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Lesson 2, quiz 1
» Home & Home Office
Hello, Truitt
» Edit profile
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Quiz: Lesson 2, quiz 1
Quizzes are designed to give you a chance to test your knowledge.
Please feel free to take this quiz again. We will update your score.

1. Where should you place your navigation bars on a Web page?
A.

Top or bottom of the page

B.

Top or left side of the page

C.

Right or left side of the page

2. True or false: In Web design, always use contrasting colors (colors next to each other on
the color wheel).
A.

True

B.

False

3. What's royalty-free artwork?
A.

Illegal images you're not allowed to use.

B.

Art that hasn't been touched by a monarch's grubby hands.

C.

Copyrighted images obtainable for free or with a flat purchase fee.

4. True or false: You should stick with one font to avoid all that typeface clutter.
A.

True

B.

False

5. Which technique will help an assistive technology read the images on your Web site?
A.

Add alt text to <img> tags.

B.

Embed explanations in the HTML code of every page.

C.

Use sign language icons.

6. True or false: Digital photos can only be made with a digital camera.
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True

B.

False
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Lessons - Web site basics
» Home & Home Office
Hello, Truitt
» Edit profile
» Sign out
» Online classes
» Your classes
» Contact us
» FAQ

View your shopping cart
Web site basics
» Lessons
» Message board
» Class materials

Lesson 3

Welcome to your lessons. Some lessons may have quizzes or
assignments for additional learning. Don't forget to join your fellow
classmates and instructor on the message board.
» View single page

Gettin' WYSIWYG with it

» Digital Photography
» Everyday Printing
» Everyday Computing
» Digital Entertainment
» Activity Center
Browse & Buy
» Home & Home Office
Store
» Rebate Center
Product Support
» Support &
troubleshooting
» Software & Drivers
» Warranties & services
» Register your product

Now that you've planned your Web site, you've got to build it. Don't worry though, in a lot of ways, the
hard part's behind you. The Web abounds in sites made with WYSIWYG (What You See Is What You
Get) tools for people who don't know a lick of HTML (Hypertext Markup Language). A few hundred
bucks gets you a software package that can turn out professional-looking Web sites as easily as a
word processing document. Or, if you're willing to work a little harder, you can make perfectly fine
sites from scaled-down but free software of the same ilk.
Some free (or free if you already have the software) Web site builders you can choose from include
the following:


Netscape Composer : This nifty addition to Netscape Communicator comes fully functional
with all the trimmings for making complex Web sites. Netscape Composer is shown in Figure
3-1.

Figure 3-1: Netscape Composer.



Desktop publishing or presentation software: Many layout applications, such as Quark
and others, include options that let you save files as HTML.
Word processor: Word processors that convert pages to HTML won't crank out the most
advanced sites, but they're simple to use. Many include commands such as File > Save As
Web Page, which perform the magical HTML conversion.

Other than the fact that you've already paid for them, the advantage of designing your Web site
with a word processor or desktop publishing program is familiarity -- you already know the
commands, you just have to apply them to a Web page.

The following are some price-tagged Web site builders:



Microsoft FrontPage : Available with Microsoft Office Developer Suite or separately for less
than $200, this versatile tool handles complex and simple Web sites.
Macromedia Dreamweaver : The biggest title in the WYSIWYG market. It rings for $399, but
lots of folks say it's worth the price.

Try trial versions of the packaged software to see if the dough is worth it.

Brush up your HTML

So you know HTML? More power to you. That means you can take advantage of cheaper, more
versatile programs built for people comfy with the language. Search around for an HTML Editor at

Download.com or Shareware.com and let the free and low-cost software (like the editor in
OpenOffice.org /) rain down on you.
Graphics: is the Web prejudiced?
The Web can be very picky about just what sorts of images it
chooses to consort with. In other words, you've got to format your
graphics just right to get the Web to recognize them.
To properly whip images into shape, you'll need some sort of
graphics tool. Adobe Photoshop rules this market, but it costs
somewhere in the neighborhood of $600. Several cheaper
alternatives exist out there, such as Paint Shop Pro and
GraphicConverter. You can also pull off limited image
manipulation tricks with free software like iPhoto, which comes
free in Macintosh computers, and similar programs that come with
various PCs. Finally, HP offers a free image editing program
called Photosmart Essential.
You'll want two principal features out of any graphics software: the
ability to both reduce an image's size and change its format.
Without these functions, get ready to bang your head against your
monitor, because your images won't work for the Web.
Save it for the shrink

Smaller files load faster, which means a Web page loads faster,
thus, visitors will stick around longer. Which means you'll want
your image files as small as possible. Case closed.
I'm not talking about reducing all the pictures of you Web site to
the size of postage stamps. I'm talking about three different
approaches that can each significantly decrease an image's file
size:


Reduce the resolution: When scanning an image or
tinkering with it in a graphics program, keep its resolution
no larger than 72 dpi (dots-per-inch). They say most
monitors display at 72 dpi anyway, so it's pointless to post
a picture with a resolution larger than that. Your graphics
software should come with a function similar to Image >
Resize, shown in Figure 3-2, Paint Shop Pro that lets
change the image's size.

Work on your home page
while away from home

» HP Pavilion notebook PCs
HP notebooks to help you
discover, create and enjoy
multimedia experiences at
work and play. Organize,
share, and protect your
photos with HP Image Zone
software.

Figure 3-2: The Resize dialog box in Paint Shop Pro.


Ditto for height and width: Adjusting the height and width
of a picture -- which you'll likely want to do anyway to make
it fit on the page better -- can also reduce file sizes
dramatically. Most graphics tools let you make such
adjustments with the same function that adjusts resolution.
When resizing images in this way, always keep them in
proportion both to your Web page (no image should look
too big or too small) and to the image's dimensions -- that
is, when you widen the top, you widen the sides by the
same percentage, else you'll stretch the image.

Don't be frightened if you've got a digitized image too large to
fit on your screen. With graphics, it's better to start big and
shrink. Enlarging an image from a smaller size always

compromises quality.



Tend to your crops: Cutting unnecessary fat from a
picture -- say, an ugly background or an ex-partner -- helps
reduce size and focus an image on the details you find
most important. A cropping tool, standard with any graphic
program, lets you remove these unwanted sections from
an image. Figures 3-3a and 3-3b show cropping in action.

Figure 3-3: Uncropped photo of a rascally cat.

Figure 3-3: Cropped photo of a rascally cat.

Resizing Images in HTML won't cut it. You can resize large
images with HTML and Web site building tools to fit on a page,
but that won't change the image's file size, which could still
take a long time to download. After you get the image to a size
you like, reduce it with an image-editing program.

Choosy designers choose GIF (and JPEG and PNG)

The compressed image formats known as GIF (Graphic
Interchange Format), JPEG (Joint Photographic Experts Group),
and PNG (Portable Network Graphics) load faster and generally
behave better online than larger image types such as TIFF
(Tagged Image File Format).
Many graphics tools let you switch between the three with a Save
As or Convert command. Here's a quick overview of each type of
graphic:



GIF shrinks image sizes by reducing their colors, so it's
best for clip art and illustrations.
JPEG maintains an image's color as it compresses other
visual information from a file, making it best for photos.



Although JPEG photos aren't as crisp and clear as, say,
TIFF photos, they get the point across well enough for
Web viewing.
PNG (pronounced PNG) was developed specifically for the
Web. It compresses more effectively than GIF, and even
better, it doesn't chuck out as much visual information as
JPEG. However, it's still relatively new and hasn't fully
caught on yet.

Get graphic
We've already talked about those times you need to create your
own images. When photos and existing clip art just won't do, it's
graphics-creation tools to the rescue.
A number of programs let you do all manner of graphics magic for
producing logos, navigation bars, and other images. Some of the
big names in this category include Adobe Photoshop and
Illustrator , Macromedia Fireworks , Corel Painter , and Paint
Shop Pro , among countless others. These pricey applications can
handle any imaging task you throw at them -- from removing red
eye glares to adding special effects like lightning bolts. Of course,
the more goodies, the pricier they get; not to mention harder to
learn (you could spend all night just adding a special effect like a
lightning bolt to a photo). Don't sweat which one to buy though -this is the reason software companies created trial versions of
software.
Many graphics programs today slice images directly into Web
pages, generating the necessary HTML for you. Make sure
any image software you buy has this feature.

Cheaper solutions lie in the category of freeware and shareware
graphics tools made specifically for the Web.
A number of such programs out there do nothing but create and
edit image maps, buttons, icons, ad banners, and other helpful
doo-dads without all the extra stuff you don't need. Here are a few
programs to consider:






2D&3D Animator : Let's you create animated GIFs and
fancy font and text tricks, plus 30 customizable templates
for logos, buttons, and other decor.
Favicon.com : A Web site that lets you create and add a
customizable icon for your site that appears in the address
bar and favorite sites page of browsers.
Buttonz & Tilez : Nothin' but buttons and tiles for your Web
site. You want buttons and tiles; they got buttons and tiles.

Printing your photos

» HP everyday photo paper,
semi-gloss
This sturdy photo paper with
a semi-gloss finish is
affordable and easy to use
for printing images, whether
you're at home, work, or
school.

Link of the possibilities
The Web wouldn't be world wide if its parts weren't connected. And its parts wouldn't be connected
without links. Links are the circulatory system of the Web, found in between and within Web sites.
Let's tap a vein, shall we?
Internal links

Every time you click an image or underlined word to go to another section of a Web site, you're
following an internal link. To add such a connection to your site's navigation bar, site map, or so on,
simply open a page in your WYSIWYG Web development tool, highlight the text you want to link, click
the program's linking function, and then choose the text or image you want the link to follow.
External links

You don't want to drive visitors away from your Web site, but providing them with links to other pages
can make a visit to your site a more enriching experience. It's standard Web practice to link words or
phrases on one's site to others with more information on the topic, as well as listing favorite links or
some variation thereof on a separate page or section of a page.
WYSIWYG tools let you create external links as easily as internal links. Just highlight the desired text
or image, click the program's linking function and type the entire URL of the page to which you'd like
to link. Figure 3-4 shows a linking in progress.

Figure 3-4: A linking in progress in Netscape Composer.
View a larger version of this image.
Sneak a preview
No need to work in a vacuum when building your Web site. It's
quite simple to preview your Net newborn before uploading it to
the Web. Just follow these simple steps:

Class participation

There's nothing like peer
support in a learning

1.
2.
3.

Make a new directory or folder for the project.
Save the Web site's files to the project directory or folder.
Open any of the files in your Web browser. For example, in
Internet Explorer, choose File > Open, and click Browse
to navigate to the appropriate directory, as shown in Figure
3-5.

environment. If you ever
belonged to a study group in
school, you'll remember the
value of putting heads
together to discuss the
subject and work through
solutions. The Message
Board is your online studygroup lounge, where you can
meet your classmates, share
your reasons for signing up
for this class, and talk about
your goals and dilemmas as
you work through this
course. You never know who
has the answers you seek.
Preview your site on paper

Figure 3-5: The Browse dialog box in Internet Explorer.
View a larger version of this image.
4.

Select the file, and click Open to open the desired file.

Many WYSIWYG Web development programs come with
preview tools that show Web pages as they develop.

Rip it off

When you see some nifty design on a Web site and don't know
how the designer pulled it off, go ahead and take a look under the
hood. Either use your browser's View > Source option to see its
HTML or download the page through the browser's File > Save
As command. From there, you can view the source HTML either
on the browser or in your Web-building program.
Figure 3-7 shows what the source of a Web page can look like.

» HP Deskjet 6940 color
inkjet printer
If you want fast, affordable,
wired Ethernet printing, plus
direct photo printing, check
out the HP Deskjet 6940
color inkjet printer. You'll find
it easily handles highvolume home office projects
ranging from everyday
black-and-white documents
to large (up to 8.5 x 24"),
borderless photos,
brochures, presentations,
and more.

Figure 3-6: The source of The New York Times on the Web. Good
luck figuring out that mess.
View a larger version of this image.
HTML and JavaScript code can be used by anyone, but you'll
need permission to use a proprietary program on a Web site,
such as an application for shopping, or the content on a site.

Moving on

Congrats, you've birthed a Web site. Now you need to find a
home for it. But I'm getting ahead of myself; that's the subject of
the next lesson. For now, take a crack at the assignment and quiz,
and then pop by the Message Board before you move on to
Lesson 4.

Congratulations on completing the lesson! Don't forget the following:
» Assignment:Let's get it together
» Quiz:Lesson 3, quiz 1
» Return to the lessons list to get a quick overview of the entire class
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Set your web site assignment
» Home & Home Office
Hello, Truitt
» Edit profile
» Sign out
» Online classes
» Your classes
» Contact us
» FAQ
» Digital Photography
» Everyday Printing
» Everyday Computing
» Digital Entertainment
» Activity Center

View your shopping cart
Assignments are designed to help you apply the information learned in the lessons.
Let's get it together
1. Download Netscape , and open Netscape Composer via the command Window >
Composer.
2. In Composer, design your Web site's framework -- its title or logo, navigation, and
body elements. Add images using the image button on the toolbar.
3. Save the page, and preview it in Netscape Navigator by selecting Window >
Navigator and File > Open . From there, tinker all you like. Let the rest of the class
know about your progress.
You have completed this assignment.

Browse & Buy
» Home & Home Office
Store
» Rebate Center
Product Support
» Support &
troubleshooting
» Software & Drivers
» Warranties & services
» Register your product
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Lesson 3, quiz 1
» Home & Home Office
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View your shopping cart
Quiz: Lesson 3, quiz 1
Quizzes are designed to give you a chance to test your knowledge.
Please feel free to take this quiz again. We will update your score.

1. What does WYSIWYG stand for?
A.

What You Say I Wash Your Gnu?

B.

What You See Is What You Get

C.

Wish You Saw Ingrid Wallop Your Grandpa

2. Name three Web-friendly image formats.
A.

MP3, CIA, and BUTT

B.

MADD, NRA, and CSI

C.

GIF, JPEG, and PNG

3. What's the most common image format for photographs on the Web?
A.

JPEG

B.

Polaroid

C.

Tintype

4. To see what makes a Web site tick, how do you view its HTML code?
A.

Hack into the Web site's server using daring yet illegal techniques.
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B.

Click View > Source on your browser.

C.

Beg and plead with the Web site's administrator's until he or she relents.
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Lesson 4

Welcome to your lessons. Some lessons may have quizzes or
assignments for additional learning. Don't forget to join your fellow
classmates and instructor on the message board.
» View single page

A place in the fun
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Why do we need ISPs (Internet Service Providers) and their overpriced fees, network crashes and
sundry other problems, especially if we can get on the Internet ourselves? After all, it's possible to
use basic Internet protocols (the languages that computer networks use to talk to each other) and
the right software to connect your computer directly to the Internet. But it's not a good idea.
Getting your computer closer to one of the Internet's backbones -- its main thoroughfares for
trafficking data -- could open it to hacker attacks, create slow download times for people visiting your
Web site, and your ISP might not even allow it. That's why, however grudgingly at times, most people
let their ISP or some other Web hosting service maintain their Web site on the Internet.
ISPs have fast, constant connections to the Internet and can handle large amounts of data traffic
through large computers called servers . These servers store vast amounts of e-mail and Web pages
and route Internet traffic from one place to another. ISPs, then, are not only your gateway to the
Internet, but also your storage locker, post office, mail carrier, and gallery space rolled into one.
Figure 4-1 shows a sample map of what the Internet backbones of Europe look like.

Figure 4-1: The Internet Backbones of Europe.
ISP SOS
You're more than likely hooked up with an ISP such as AOL, SBC,
AT&T, Earthlink, or one of several others. You're probably also
well aware of the services it provides and the rates it charges for
them. Now it's time to double check what your ISP offers in terms
of Web hosting -- a service that can make or break a
customer/ISP relationship.
Signing up with an ISP's Web hosting service gets you access to
its Web server, where you post the pages, images, and other files
for your Web site. When people visit your Web site, their
computers connect to that server. If the server shuts down, so
does your site -- until the ISP fixes the problem or you move to
another ISP with a more stable Web hosting service.
To make sure your ISP fulfills your Web hosting needs, ask
yourself these questions:


Does my ISP fulfill my needs today and tomorrow? Any
ISP can handle a simple informational Web site, but if you
eventually want to offer e-commerce (which we'll explore in
Lesson 7), you'll want an ISP that provides features such

Ink and photo paper deals

» Ink and photo paper value
pack
Print professional-quality
photos in the comfort in your
home and save even more
per print with these ink and
photo paper value packs.









as a secure sever, shopping carts, and credit card
processing. Make sure your ISP's services can grow along
with your needs.
How far is my ISP from an Internet backbone? You'll
want an ISP linked as close as possible to an Internet
backbone, preferably one hop , or connection, away. The
more hops your page resides from a backbone , the
longer it will take to download.
What am I willing to pay? The thousands of ISPs out
there offer a confusing array of services, features, and cost
structures. Figure out what you need and do some
comparison shopping. Among other things to look into,
explore the quality of an ISP's support. Does it provide
phone or e-mail support? What's its typical response
turnaround time? Take a look at Internet message boards
and forums to see what their past and present users have
to say of the service they get or got.
What about the extras? Unlimited e-mail addresses,
functionality for auctions, chat and message boards -- the
sky's the limit on what ISPs can offer above basic Web site
hosting. Figure out what you want by perusing the
premium services of the big ISPs. Then figure out what
you're willing to pay for them.
Is the e-mail access direct? It may sound crazy, but
some of the cheaper ISPs don't directly handle your e-mail
on their servers. Instead, they forward it to another
account, making you pay extra to maintain another Internet
account. Don't put up with this sort of nonsense -- get an
ISP that takes care of your e-mail.

These Web sites may help your hunt for an ISP:




The List : Like the name says, this Web site lists a ton of
ISPs around the country, as well as in your area. All are
searchable by area code or state, with pricing information
to boot (though you'd be wise to double check its
information).
WebHosters.com : Information on different hosting
companies in 12 different categories.

Figure 4-2: Figure out who hosts what at WebHosters.com.


HostReview.com : The skinny on several hosting
companies, searchable by price range, space provided,
and operating system.

The minimum

At the very least, you want these features from your ISP:








At least 20 MB of disk space: Those images, HTML files,
and other content add up in size after a while, so you'll
want plenty of room.
At least a GB of monthly data transfers: Big Brother is
watching. ISPs track the amount of data transferred when
a visitor downloads your Web pages and associated
images or files. You'll want an ISP that allows at least a GB
(or a billion bytes) a month, because, as I said earlier, the
size of those files start to add up. An ISP could either
charge you for additional bytes transferred over the limit or
temporarily shut down your Web site.
FTP access: FTP (File Transfer Protocol) is the means by
which you upload content from your computer to a server.
We discuss it more a little later.
E-mail: Make sure the ISP includes e-mail that you can
pick up directly from its mail server and that it offers as
many e-mail addresses as possible. You may only need
one now, but as your family or business grow, new e-mail
addresses will come in handy.

Think twice about freebies. Companies that offer free Web
space often entangle the deal with lots of strings, such as
giving you a long, complicated domain name. These
services can be great for personal Web pages and free
Web-page practice, but for professional work, you'll want
the freedom and flexibility that comes with paying cash.

The name says it all
When it comes to the Web sites, the name says it all. The URL
provided by ISPs tends to be long and garbled, like
http://www.cheapsites.com/rascallycats/home.html .
That's fine for personal Web sites, but if you're going pro with this
baby, or just want it to feel that way, you need to pay to get a URL
that trips off the tongue as smoothly as
www.rascallycats.com . So let's explore Web site naming.
What's in a name?

When thinking up a name for your Web site, first identify your
audience. Teens? Suits? Sportos? Then figure out a name that
would appeal to them. Consider one of these general approaches
to domain naming:






The Subject Name: URLs that refer to the Web site's
market or topic, like www.rascallycats.com, are easy for
users to remember and find. The downside: most of the
obvious and not-so obvious ones are already taken.
The Company Name: URLs composed of your company's
or organization's name in full, like
www.rascallycatenterprises.com, are easy for users to
remember and find.
The Attention-Grabbing Name: URLs that don't
necessarily relate to a Web site's topic, but draw a response
anyway. What does Amazon.com have to do with legendary
women warriors? Is Yahoo! a Web site about yahoos? The
right unusual name can get instant notice; the wrong one
could get promptly ignored.

Just like real estate property, owning a piece of the Web via a URL
comes with rules and restrictions. Keep these in mind as you think
of a name: Although .com is the most familiar URL suffix, it's not
the only one available. Your Web site could be better served
with .org for not-for-profit organizations, .net for Internet
infrastructure companies (like ISPs), foreign country abbreviations
( .uk , .jp , .au ), and a bunch of others ( .biz or .info , anyone?).

Domain delay

Once purchased, your new
domain name may not be
available for up to 72 hours
as your ISP gets everything
set up. In the meantime, you
can get immediate access to
your Web site through the IP
address (a set of numbers
along the lines of
209.54.64.31) your ISP
should give you.

You have to prove affiliation with the government to use .gov or
with an educational institution for .edu.

Here are some other things to remember when pondering domain
names:




URLs may only be composed of letters, numbers or
hyphens (-).
A URL cannot begin or end with a hyphen.
A URL must never exceed 63 characters, not including
the .com suffix.

After you've narrowed down a choice, type it, and variations on it
into your Web browser: rascallycats.com, rascallycats.org,
rascallycats.net, and so on. You'll know instantly if it's already
taken, but if a Web site offering the URL for sale or a "server could
not be found" message pop up, you may have a shot at getting that
name.
Master of your domain

If your initial research shows that your chosen URL may be
available, spend a few minutes searching for it on one of the
domain registry Web sites.
InterNic, a Web site managed by Network Solutions , used to be
the only game in town for domain name registration. Today, a
number of Web sites offer the service, all of them overseen by
Network Solution's replacement for InterNic: ICANN (Internet
Corporation for Assigned Names and Numbers). Network Solutions
offers a nifty tool called MyNameFinder that makes name searching
a snap. However, when it comes to registering a URL, shop
around. Registration Web sites charge varying registration fees.
Go ahead and visit Network Solutions and see if
www.rascallycats.com is taken. Type in rascallycats in the
search window. Hit search , and you'll find not only
www.rascallycats.com available, but rascallycats.net ,
rascallycats.org , rascallycats.biz ,
rascallycats.info , rascallycats.us ,
rascallycats.cc , rascallycats.bz , and
rascallycats.tv , as shown in Figure 4-3. The Web site even
lists similar names , my favorite being rougishcats.com .

Figure 4-3: Eureka! www.rascallycats.com is available. No stopping
us now!
Taking it all the way

You want that name and you want it so badly, no other will do. See
if the owner will sell it to you. People do it all the time, sometimes
via auctions. Hopefully you won't have to go to that extreme to get
your name. Just do a quick WHOIS search on the Network
Solutions Web site. Typing in a domain name in use yields the
name and address of the owner.

For a little brainstorming help on the perfect domain name, visit
www.deleteddomains.com, which keeps track of domain names
people have allowed to expire.

FTP A-OK
Some ISPs offer tools to help inexperienced Web site owners
upload their pages to their servers. Since the actual ease of use of
these utilities can vary greatly, it's best to pick up a working
knowledge of how to do it the old fashioned way -- via FTP (File
Transfer Protocol).

To learn this not-really-so-daunting-as-it-sounds skill,
download a utility, such CuteFTP (http://www.cuteftp.com/) for
Windows and Mac.

Back up your images

» HP desktop storage
Whether you want to back
up your personal media and
data for safety's sake or

After installing the FTP program and opening it, it will eventually
ask you for your host name. This is the server address your ISP
should have provided you with already. If it didn't, call tech
support and raise a ruckus. It should resemble something along
the lines of ftp.rascallycats.com . Subsequent screens will ask
you for your username and password, as shown in Figure 4-4,
which also should have come from the ISP.

clear up your hard drive to
make space, look to HP for
your storage needs.

Figure 4-4: An FTP program, asking for the basics.
Once you've entered this information, you should be connected.
Find the directory on the server with a name like public_html ,
www, wwwroot, or web . This is where you'll want to put your
files. Your FTP tool will likely let you both drag the files from your
computer to the server, or let you do it through a command like
Transfer > Upload.
Test drive

Before going live, before even exiting your FTP program, you should fully test every page and every
link of your Web site. Open your Web browser to see how things turned out, and then jump back to
your FTP application to upload anew the necessary files to fix any problems. No one creates a
perfect Web site the first time out of the gate. In fact, you're highly likely to encounter any of these
problems:





Missing images: You forgot to upload the image file that belongs to a Web page, or linked it
incorrectly.
Badly formatted Text: You coded your copy the wrong way.
Bad spacing of text or objects: You misaligned something or excluded a paragraph or line
break.
Broken hyperlinks: You fubbed a link or didn't upload the page it links to.

Figure 4-5 details one such case.

Figure 4-5: This Web site needs a little work if you ask me.

Take a look at your Web site in both Internet Explorer and Netscape Navigator. The two browsers
tend to handle pages a little differently sometimes, so it's good to see them in both.

Moving on

So we've covered the workings of the Internet and ISPs, registering domain names, and FTP
transfers. Welcome to the Web. Take a stab at the assignment and the quiz, and then we'll move on
to more advanced topics that will take your Web site to the next level. Don't forget to slip on into the
Message Board to see what other students are up to.

Congratulations on completing the lesson! Don't forget the following:
» Assignment:Stake a claim on the Web
» Quiz:Lesson 4, quiz 1
» Return to the lessons list to get a quick overview of the entire class
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Assignments are designed to help you apply the information learned in the lessons.
Stake a claim on the Web
This lesson's assignment is simple enough: follow the lesson's instructions on posting a
Web site. After you've got it up, share the URL with the Message Board so we can all pick
over it (just kidding). Seriously, feel free to share and ask any questions about Web site
mechanics you may not have ironed out yet.
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Quiz: Lesson 4, quiz 1
Quizzes are designed to give you a chance to test your knowledge.

1. What does FTP stand for when talking about Web sites and the Internet?
A.

Forgot the Pizza?

B.

File Transfer Protocol

C.

Fight the Power

D.

File Transfer Process

2. Which of the following online tools identifies the owner of an Internet domain name?
Browse & Buy
» Home & Home Office
Store
» Rebate Center
Product Support
» Support &
troubleshooting
» Software & Drivers
» Warranties & services
» Register your product

A.

eBay

B.

Napster

C.

WHOIS

3. Which of the following allows you to access your Web site in lieu of a domain name?
A.

The IP address

B.

The Keymaster

4. When would you have occasion to end your domain name in.org?
A.

Government Web sites

B.

Not-for-profit organizations

C.

Web sites made for and designed by pets
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» Lessons
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Welcome to your lessons. Some lessons may have quizzes or
assignments for additional learning. Don't forget to join your fellow
classmates and instructor on the message board.

Lesson 5
Mull over multimedia

» Digital Photography
» Everyday Printing
» Everyday Computing
» Digital Entertainment
» Activity Center

Ever gone to a Web site and been driven away by a computerized
version of Wind Beneath My Wings that sounds like it was
composed on an old Speak 'N Spell? That's the peril of using
audio and video on your Web site. Sometimes a little song and
dance can accentuate a Web site and the message it conveys.
Other times it does just the opposite.

Browse & Buy
» Home & Home Office
Store
» Rebate Center

Keep the following points in mind before posting a two-hour fullscreen movie of your cat with Barry Manilow's Greatest Hits as
the soundtrack:

Product Support
» Support &
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» Software & Drivers
» Warranties & services
» Register your product

» View single page





The purpose of your Web site
The readers of your Web site
The limitations of the Web and the computers of people
visiting your Web site

If you sell yachts, a video clip of a boat's interior on your Web site
may appeal to rich male customers who probably have a
connection fast enough to view it. If you sell vacation packages for
seniors, an elderly clientele may not have the setup to watch a
film, but they may appreciate a jingle.
Know your reader, and plan around their technological limitations
(or strengths) accordingly. If you're building for the young and

Photo lab quality at home

» HP Photosmart D7360
printer
What makes the HP
Photosmart D7360 photo
printer a standout? Its
innovative touch-screen
display and large 3.4" size,
which make viewing, editing,
and printing photos a cinch.
Plus you'll get your labquality photos super fast--in
as little time as 12 seconds!

wired, or another group that you know has access to high-speed
Internet connections, load up your Web site with bandwidthchomping extras. Otherwise, build with slower machines in mind.
As a general rule, it's best to design a Web site that can be
handled by a 56 Kps modem; these days, it's hard to get lower
than that speed. This doesn't mean you have to dump all the
video and music on your hard drive in the trash. Instead, let the
viewers decide. You can always design separate versions of the
same page -- a simple version that provides low-bandwidth
alternatives, such as still-frame images in lieu of video clips and
another with all the bells and whistles. Visit Veer , shown in Figure
5-1, for an example of a Web site with lots of bells and whistles.
It's the latter type of Web site that we'll explore in the following
pages of this lesson.

Figure 5-1: Veer knows its audience -- people with the bandwidth
to watch lots of videos online.
Sound thinking
Web pages access sound from audio files in much the same way that they get pictures from an
image file. The code is slightly different (more on that in a moment), but it plops right in wherever you
want it. The trick with audio files is not getting them in a page, but choosing which types to use in a
page. Just as GIF (Graphic Interchange Format), JPEG (Joint Photographic Experts Group), and
PNG (Portable Network Graphics) formats work best for images, certain sound files work better than
others for different effects, as discussed in the following sections.

WAV format

Used by Windows (Macs use AIFF, but it's pretty much the same thing), this CD-quality format takes
up a lot of space, to the tune (as always, forgive the pun) of 10 MB per minute of sound. That means
a 40-minute song would take about 90 minutes to download with a 56 Kps modem. Fortunately,
WAVs are shrinkable in a few different ways. Using sound-editing software such as Acoustica for
Windows or iTunes for Mac, try one or all of these options:



Make it Mono: This will undoubtedly worsen the sound quality of a WAV file, but it cuts the
size by half. Still, for a four-minute song, that's still a whopping 20 MB.
Reduce the Sampling Rate: Whittling down the sampling rate, which measures the audio
quality, can cut file size further. Though again, you lose audio quality in return. Cutting the rate
from standard 44 khz CD-quality to 22 khz phonograph quality may not be worth the resulting
sound you get.

MP3

MP3 (Moving Picture Experts Group Layer-3 Audio) files are compressed sound files solve the WAV
size reduction problem by removing unnecessary information you wouldn't notice anyway during
playback. The files end up 10 times smaller than WAVs with no apparent change in quality. MP3s
have become so universal, most any music program produces them automatically when you import
WAVs into your computer from a CD.
Sample rate reductions, monoconversions and MP3 compression may reduce a 40 MB file to under 4
MB, but these options still leave you in the lurch when you want to share a whole concert or other
lengthy audio through your Web site. For this type of job, turn to streaming. When an audio file
streams, a link on a Web page plays it as it downloads, instead of playing it once the download has
finished. This way, downloading seems to go a lot faster. It's simpler for the viewer, but more difficult
for you. To stream a file, first you have to convert it to the streamable .rm format. Helix Producer will
do the trick. Once that's done, find a home for the file on a streaming server. If your ISP doesn't offer
streaming capabilities, no sweat -- a Web site such as RealServer , can take over from here and host
the file on its servers.
MIDI

MIDIs (Musical Instrument Digital Interface) files -- those typically simple yet strangely endearing
sound makers I mocked with the Wind Beneath My Wings joke at the beginning of this lesson -- are
like sheet music for player pianos. They don't contain sound; they just tell the computer how to make
sound. And, suffice it to say, computers weren't made to be musical instruments. Although you can
sometimes get decent sound from a MIDI file, they'll never approach MP3 in sound quality. However,
they've got every other format licked in the size department. Because they're little more than
instructions, MIDIs take up considerably less space than other sound formats, rarely bigger than 15
KB for most standard-length songs. Because they're so small and their quality so puny, lots of Web
sites around the Web give MIDIs away for free. Go on a MIDI hunt at a Web site such as Ifni MIDI
and see what you can find.

As with pictures, using a copyrighted song on a Web site can be illegal without

permission, so look into the legalities.

Make a joyful noise

With a cheap microphone from a computer or electronics store, you can stop worrying about all these
audio formats and make your own sounds for your Web site. Simply call up the Windows Sound
Recorder Utility or the Mac's Sound Control Panel and get noisy.
Both work like conventional tape recorders, with record, stop and play buttons, as well as sound level
monitors. Sound Recorder even comes with limited sound editing and sound effect functions.
However, for more thorough sound editing, it may be worth shelling out the dough for an application
like Syntrillium Software's Cool Edit and Macromedia's Sound Edit .
Tack on the tunes

Putting those sound files we just learned about into your Web site isn't hard, but you may have to
fake your through some HTML (Hyper Text Markup Language) if you don't know it already to ensure
you get it right. Some Web building software packages let you add audio files easily enough, but they
can bungle the process from time to time. To guarantee a Web site plays music the way you want it,
view the HTML coding of your pages and follow one of these methods:


The Sound File Link: Creating a link that lets visitors hear a sound file when they click it is
simple as establishing any other link. Just slip in this bit of code wherever you'd like the link to
appear:

<a href="yoursonghere.wav">Play This Song!</a>


The Auto-Loading Sound File: Setting up a WAV file so that it plays as soon as a page
loads takes a few extra lines.

<embed src="happy_birthday.wav" width="144" height="60"
autostart="true" loop="true"> <bgsound src="happy_birthday.wav"
autostart="true" loop="infinite">
Yes, these are two separate lines of code. That's because Explorer and Navigator use slightly
different HTML commands for some functions. Putting both versions in your HTML assures that both
browsers will read the right one and ignore the other. Height and width in the code adjust the
appearance of the sound bar, shown in Figure 5-2, displayed when the music kicks in. Loop tells the
browser to play the sound over and over again (you sure you want to put your Web site's visitor's
through this?).

Figure 5-2: The unassuming sound bar that pops up when you load a MIDI song.
Screening movies
It just keeps getting easier to make and edit video on your desktop
computer. Easier, that is, if you've got the equipment to handle it. To
make your own movies, you'll need:






Processor power, lots of RAM and hard drive space: If your
computer's a few years old and you're serious about desktop
movie making, it may be time to upgrade to a machine that has
all three of these elements in spades.
A Digital Video Camera: These can get pricey, but they're
going down in price. You can also consider alternatives -- a
growing number of devices can make movies these days. Along
with still shots, my digital camera and plenty others like it can
take 30-second video clips, which, surprisingly, are often long
enough to capture the small slices of life I like to string together
with my movie-making software. Of course, if you're trying to
record a school play or wedding, you'll need longer-lasting
firepower.
A Video Capture Card or FireWire (a.k.a. IEEE 1394): You'll
need either of these to pump video from your camera to your
computer. FireWire, an easy-to-use connection technology, lets
you simply plug your camera to your computer. From there, your
video software records the input to your hard drive. Video cards
tend to be a little harder to use, but they operate on the same
principle.

Cinematizing your Web site

As with audio files, HTML gives you the option to link to a video file
you've uploaded to the server or embed it to the Web page. Use the
following code to pull off this bit of magic:
<embed width="100%" height = "100%" fullscreen="yes"
src="welcome.mov">
Visitors need a plug-in for their browsers to play video, so be sure to
link to the Web site for such plug-ins as Apple's QuickTime , Real
Network's RealPlayer , or Microsoft Windows Media Player to help

Technology for digital
enthusiasts

» HP Media Center PCs
The next generation of home
entertainment; access TV,
movies, music and photos,
when and how you want.

them see it. Once in place, it should look something like Figure 5-3.

Figure 5-3: A video of Leonard Nimoy singing an ode to Hobbits.
The streaming solution

Add up the number of colors, image sizes and frames in just one minute
of compressed video and you've got yourself a file with a download time
that dwarfs that of audio files. Though that single minute of footage fits
into a Web site just as easily as an audio file, it can take 148 minutes to
download on a 56 Kbps modem, enough time to drive to the video
store, pick out a movie, come back, freshen up in the bathroom as you
make popcorn, and watch the rental.
How to get around this massive problem? Why, streaming, of course.
The technology we covered above for audio works just as well and just
the same for video. After converting the file in the .rm format, figure out
if your ISP can stream. If not, try a streaming service like Real
Networks.
Alternate animations

If the thought of dealing with super-sized video files gives you a headache, you'll appreciate the
manageability of animation. Byte for byte, the three main forms of Web animation can't be beaten for
entertainment value, as discussed in the following sections.

Animated GIFs

Sequences of images strung together in a single file and played as a loop are made with a GIF assembler,
such as GIF Construction Set . The good news is you can plop them right in the Web site the same way
you would a regular GIF: <img src="name.gif"> (or just let your Web site builder handle it). The bad
news is the more images they animate, the larger they become and longer they take to download.
Shockwave

Shockwave creates animations with interactive graphics, text, and sound, making it a popular format for
cheap and easy throwaway games, like the one shown in Figure 5-4. Viewers need a plug-in to play
Shockwave files, but most browsers come equipped with it these days. Given that Macromedia Director,
which makes Shockwave files, costs $1,000 and takes some time to learn, you may just want to tide
yourself over with downloading free and legal Shockwave files to run on your Web site from such sources
as Shockwave.com .

Figure 5-4: Fruits, a shockwave game on FreeArcade.
To embed a Shockwave file (which is saved in the .dcr format) on a Web page, plop in this code:
<embed src="myfile.dcr" width="300" height="300">
For Internet Explorer, use this longer bit of code:
<object classid= "clsid:166B1BCA-3F9C-11CF-8075-444553540000"
codebase= "http://active.macromedia.com/director/cabs/sw.cab"

width="300" height="300" name="shocked"
id="swmovie1"> <param name="src"
value="yourfile.dcr"> <embed src="yourfile.dcr" width="300"
height="300"> </object>
Flash

A simpler form of animation, and for a far simpler price. Flash , also by Macromedia, costs $300 and isn't
as hard to learn as Shockwave. Its file sizes often turn out smaller than Shockwave files to boot.
Try this code to put Flash in your Web site:
<object codebase= "http://download.macromedia.com/pub/shockwave/cabs/
flash/swflash.cab#version=4,0,2,0" id="abc" width="500" height="143">
<param name="movie" value="images/flash.swf"> <param
name="quality value="high"> <param name="loop" value="true">
<param name="bgcolor" value="#ffffff">
<embed src="images/flash.swf" swLiveConnect="FALSE"
width="500" height="143" quality="high" bgcolor="#ffffff"
type="application/x-shockwave-flash"
pluginspage= "http://www.macromedia.com/shockwave/download/
index.cgi?P1_Prod_Version="ShockwaveFlash"></
embed> </object>
What's your PowerPoint?

One of the oldest forms of multimedia, the slide show, still thrives on the Web, thanks in large part to
presentation software such as Microsoft PowerPoint. This program provides an Internet assistant that
turns presentations into HTML pages that look no different than they do in the program.
Converting PowerPoint presentations into HTML files is a breeze. Simply open the presentation and
choose File > Save as HTML. From there, follow the Internet Assistant's instructions.
Figure 5-5 shows a screenshot of a PowerPoint presentation that's been saved as a Web page.

Figure 5-5: Using the Internet assistant to convert a PowerPoint presentation into a Web page.
And that's that. From there, you can upload the slide show so it plays as a page or create links to it.
Be warned, though, that presentations with lots of animations and sound can take a while to
download. Although you may find it convenient to load an existing PowerPoint file on the Web, your
visitors may not. Turning the images and animations of your Web site into separate Web pages that
users can peruse as easily as they could a PowerPoint document will save them time and grief.
PDF-Fort
PDF (Portable Document Format) is the online standard for documents, a universal format for
duplicating word processor and desktop publishing files that can be read by everyone who has a copy
of the free and widespread Acrobat Reader application. The universality of this format makes it
perfect for forms to be printed and filled out or large documents too bulky to read over the Web, since
all users (regardless of their computer platform or ownership of a particular word processor) have
easy access to it.
Putting PDFs on your Web site is a simple matter of uploading them and linking to them as you would
any other page. Creating them is the tricky part. Well, not really. Most any document-producing
application has a PDF function, like the Create Adobe PDF button in Microsoft Word. A handy article
from Adobe details instructions for many of them.
Moving on

You have a lot of multimedia-related goofing off ahead of you. I won't stand in your way, but I will ask
that you eventually do the assignment, take the quiz, and visit the Message Board. Then I'll catch
your act in Lesson 6.

Congratulations on completing the lesson! Don't forget the following:
» Assignment:Mull over multimedia
» Quiz:Lesson 5, quiz 1
» Return to the lessons list to get a quick overview of the entire class
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Assignments are designed to help you apply the information learned in the lessons.
Mull over multimedia
Multimedia doesn't belong on everyone's Web site. If you can't find a reason to include
audio, video, and/or other multimedia on your Web site, don't both putting it there. And if
you have thought up a use for any of these features, make sure you've thought carefully.
Ask yourself if the content will keep users sticking around your site.
So that's your assignment this time around. Sit down and think up what multimedia you
could put on your Web site and whether the site would be better off for it.
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Quiz: Lesson 5, quiz 1
Quizzes are designed to give you a chance to test your knowledge.

1. True or false: WAV is a video format.
A.

True

B.

False

2. When does a streaming media file begin to play?
A.

The computer has scanned, sniffed, shaken and stirred it

B.

As soon as it starts downloading

C.

When pigs fly

3. True or false: Believe me, the last thing you want to do is provide links to Web sites with
plug-ins. You don't want those getting in the wrong hands.
A.

True

B.

False

4. Which solution will get a word processing document or desktop publishing file on the Web
in a format all computers can read?
A.
B.
C.

Put it in Adobe's PDF.
Contact an illegal document converter who will do the job for you in his underground
lab.
Pray it all works out.
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Welcome to your lessons. Some lessons may have quizzes or
assignments for additional learning. Don't forget to join your fellow
classmates and instructor on the message board.

Lesson 6

» View single page

About search engines and directories
The Web site's done. It's posted on the Web. So why is nobody
(beyond friends, customers, or family who you've shown it to)
stopping by? Because you haven't listed it with the major search
engines and directories.

Great add-ons

A search by any other name
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Search engine is one of those terms that people often misuse, like
Frisbee for flying disc or Coke for soda. Once and for all, let me
set the record straight:






Search engine: A database of Web sites already found
and categorized with a spider (see below). It may look like
the engine is searching the entire Web when you enter a
phrase in the keyword field, but in reality, it's scanning its
databases for matches.
Spider : An application that combs through the Web
looking for your desired information. It browses as a
human does, only far faster and more thoroughly,
gathering information on a page then following all the links
it finds there to new pages, where it gathered still more
links.
Directory: A listing of Web sites ranked and rated by
humans. A few examples, include Looksmart , Open
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Directory (used by the likes of AOL Search , Google ,
Lycos , and Netscape Search ), and Yahoo! Directory .
Web Site submissions
Although a spider would theoretically get to your Web site in due
course, when you consider the millions of pages it has the comb
through, you can see how it might take a while. Because spiders
use links to conduct their searches, one way to boost your Web
site's visibility is to crank up the number of links per page. A
simpler and faster approach is to alert the major search engines,
which will index your Web site, placing it in the spider's radar.
Figure 6-1 demonstrates how to submit to Google .

Figure 6-1: Go global by submitting that URL to Google.
You'll follow a similar procedure for the other major search engine
Web sites. Just look for the Submit Your Site link. Among the
other search engines to try:





AllTheWeb.com
Teoma.com
AltaVista
MSN Search

Submit your Web site map to a search engine -- its many links
will make your site ever more visible on the Web.

Some directories, such as Looksmart and Yahoo! Directory,
charge a fee for the privilege of submitting to them. Others,
namely Open Directory, charge nothing, but don't guarantee a
listing. You submit to either type of directory the same way you do

to a search engine. Go to Open Directory (since it's free, after all),
navigate to the category that best fits your Web site, select Add
URL in the upper-left corner of the page, and then fill out the form
that asks for your URL, title, and description. And you're done.

Following the sign up instructions of any search engine or
directory increases your Web site's chances of inclusion.

Search engine submission scam?

So few search engines and directories operate these days, you
can easily submit your Web site to the major ones in under an
hour. Search engine submission services such as SubmitIt.com
do the same work for a fee, although they can be worth the money
-- many will finagle better placement on search engines than you
could muster simply by submitting a Web site yourself. Think of
them as agents, middlemen who broker you a better deal.
Then again, with a little extra work, you can save that money and
vastly improve your site's ranking with Web sites through the
miracle of meta data, the subject of the next section.
Miraculous metadata

When simply listing your Web site with a search engine and directory doesn't give it the attention and traffic you
crave, it's time to turn to metadata. Like human DNA, the HTML meta tags that hold metadata remain unseen
to the casual viewer, but they hold vital information about the range of topics covered in the Web site.
Meta-controlling your Web site's search engine listing

How about an example? BookPeople is a great independent bookstore in Austin, Texas, with a Web site that
happens to use meta tags very successfully, as Figure 6-2 demonstrates.

Figure 6-2: Lurking beneath this innocent Web site is some powerful metadata.
Visit BookPeople and use the View Source command on your Web browser to see the following:
<HEAD> <TITLE>BookPeople | The Largest Bookstore
in Texas</TITLE>
<META NAME="keywords" CONTENT="bookpeople, bookstore,
coffeehouse, books, book, newspaper, newspapers, magazines, magazine,
read, reading, writing, write, bookkid, bookkids, publisher, publishing,
publishers, author, authors, children books, austin, texas, tx,
lamar, independent bookstore, books to read, story, stories, tales,
hardcover, papercover, hardback, softback, bookreader, bookreaders,
bookmark, gifts, accessories, herbs, coffee, store, health, title,
titles, subject, subjects, new age, religion, philosophy, science,
psychology, computer, computers, occult, bible, web, internet, crafts,
jewelry, stationary cards, card, cards, nonfiction, fiction, science
fiction, self-help, help, imports, audiotapes, books on tape, regional
titles, local, gifts, religions, drinks, aroma, research, study,
paperbacks, hardbacks, paperback, hardback, articles"> <META
NAME="description" CONTENT="BookPeople is an independent 4 stories
40,000 square feet bookstore located in Austin, Texas. It sells
books, magazines, books-on-tape, cards and stationary, jewelry,
and arts and crafts from around the world.">
Both the keywords and description attributes of the meta tag can make a huge difference in your Web site's
search engine placement. You can dump as many terms as you like in the keywords -- whatever it takes to get
noticed. The description can also help draw people your way, as a search for bookpeople on Google will

demonstrate. Figure 6-3 shows the results.

Figure 6-3: The results of searching for bookpeople on Google.
Does that text look familiar? The top line is the information listed in the <TITLE> tag, which also appears at the
top of the window when you open the page. The second line has been taken directly from the description tag,
giving readers and instant explanation of what the Web site's all about.
When a search engine returns results on a site, it lists what it finds in the <TITLE> tag and meta description
tags. Both of these tags, then, are essential to making a good first impression.

If you've got the time, add meta tags to all your Web site's pages as time permits.

Keywords are key

And don't forget the keywords part of the meta tag. Listing words or phrases relevant to your Web site help a
search engine's spider categorize your site as it includes all the text and meta data it finds there. A site about
rascally cats may never explicitly mention rascally cats, but if its metadata does, it goes straight to the top of the
rascally cat heap. The more words -- no matter how obvious -- in meta tags, the better a site's placement in
search engines. In other words, meta tags ensure your site gets listed the way you prefer.

You should list any and every word remotely related to your Web site, even the obvious ones;
however, using misleading keywords can get you in trouble. Although throwing in the names of your
competitors may draw readers, the practice could get you kicked off a search engine.

It's all in the promotion

Way back when, Web sites had the cash to promote themselves
through Superbowl ads, blimp placements, and even sock
puppets. Now they've turned to cheaper methods, some of which
could be right for you.


Google AdWords : The Web's leading search engine sells
placement on its well-trafficked Web site, but wisely keeps
the sponsored links clearly marked that way so as not to
harm its integrity and lose its audience. Note in Figure 6-4
how the sponsored link up top is a Premium Listing .
Premium Listings cost the most. Those links off to the right
have been purchased through the more reasonable
Google AdWords. This program charges you only when
someone clicks your ad. After attracting a set number of
clicks within your budget, Google pulls the link until you
pay for another round.

Figure 6-4: A Google search turns up clearly demarcated
sponsored links.




Link Swaps: In this proven promotional technique, Web
sites simply swap links, essentially recommending each
other's sites to their readers. The approach works best for
sites that complement each other but don't directly
compete. To set up a swap, simply contact the site
administrator (listed on the site) and ask. If the site wants
you to post a link fancier than text, like a logo or button,
ask for the same treatment in return. Link swaps will
improve your Web site's traffic beyond the
recommendations send its way. As mentioned above,
search engines not only follow links to conduct their
searches, some even rank sites based on the number links
leading back to them, a better-than-nothing indicator of
how worthwhile a site is to visit.
Constant Communication: When promoting your Web
site, sometimes word of mouth is the best way of gaining
new customers. And how to get good word of mouth?
Why, through good customer service, of course.
Customers appreciate hearing from Web sites about where
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their product is shipping and when it should arrive, as well
as package tracking information. Clients of service sites
appreciate status reports. Even readers of content sites
that aren't selling anything like to get an update about new
site content every now and again. Keeping folks in the loop
keeps them coming back to your Web site and
recommending it to friends.
This just in . . .

The Web isn't static. It's constantly changing, growing, and shedding, and to be taken seriously on it,
your Web site has to do the same right along with it. If you don't replace old content and spruce up
your site in other ways every now and again, people will get bored with it and stop coming back. Even
more distressing, some search engines may drop you if they don't detect any new activity over a
period of time.
If you don't have much in the way of new material to add to your Web site, don't sweat it. You have
other options for keeping things current:





Monthly newsletters about your company, industry, field of interest, or, in the case of a
personal Web site, family and friends.
Monthly contests that entice readers back by playing on their greed.
Bulletin boards or live chat areas the keep visitors coming back to keep up with discussions.
Free giveaways if you're really desperate.

Syndication all right

Rather than make you own content, let someone else do it for you. Various services out there provide
syndicated text, photos, multimedia, and other content that you can run on your Web site for a fee. A
few, like FreeSticky , offer its wares from over 1,000 sources for free. Once you sign up and plop its
code in your Web site, the content will start flowing in.
Affiliation

To give the illusion of staying current and to make some green on the side, sign up with an affiliate
program. Doing this allows you to offer an ever-changing catalog of products from a larger ecommerce site. Bonus: you get a cut of the take every time you send business to the site. When
someone follows a link from, say, rascallycats.com, to an exotic cat food supplier, the supplier gets
the sale but you get a small percentage.
Look over some of the affiliate programs out there with a visit to Linkshare , featured in Figure 6-4.

Figure 6-5: A world of affiliate programs awaits through Linkshare.com.

Affiliate with caution. Your visitors may appreciate finding products related to your
industry or field of interest on your Web site. Then again, they may treat the affiliate link as
crass advertising. Figure out what your audience can tolerate regarding affiliate
advertising before adding it to your Web site.

Moving on

Proclaiming your Web site's greatness through these methods is one thing, but people won't keep
coming back unless you've put your content where your mouth is. Next up, we'll learn how to keep
their interest through interactivity . . . after the assignment, quiz, and a Message Board visit.
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Assignments are designed to help you apply the information learned in the lessons.
Keywords are key
1. Hunt down five Web sites that complement but don't compete with your Web site
and collect their contact information to ask about link swaps.
2. Enter your Web site's title and description at the beginning of its HTML code.
3. In the keyword section of your HTML code, think up 25 to 40 keywords relevant to
your Web site.
4. Cut and past these meta tags on every Web page.
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Quiz: Lesson 6, quiz 1
Quizzes are designed to give you a chance to test your knowledge.

1. What's a search engine?
A.
B.
C.

A search engine searches for Web sites from a database compiled with a spider
program.
An amazing technology scientists hope will eventually replace the combustible
engine.
The thing that keeps hunting parties going until they've found what they're looking for.

2. True or false: Meta tags are essential for every Web site.
A.

True

B.

False

3. Which of the following is a good way to build a community of loyal customers for your Web
site? (Check all that apply.)
A.

Great customer service

B.

Adding a bulletin board or chat feature

C.

Bad customer service

D.

Adding an affiliate program

4. True or false: There's no better way to get your Web site noticed than to pay a search
engine submission service to do the work for you.
True

A.
B.
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Welcome to your lessons. Some lessons may have quizzes or
assignments for additional learning. Don't forget to join your fellow
classmates and instructor on the message board.

Lesson 7
A brief history of Web interactivity
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Clicking links, the Web's "Gimme That" option for computer users,
is the earliest and most basic form of online interactivity. But it
wasn't enough. Though an extremely important and useful form of
interactivity, Web site developers soon needed a way to get more
information from visitors and do more with it.
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HTML (Hypertext Markup Language) forms and CGI (Common
Gateway Interface) came to the rescue just in time. Words,
pictures, and sound are great, but regular HTML and multimedia
can't handle some of the more useful Web services such as
search engines, e-commerce (electronic commerce), Web-based
e-mail, and instant polls. These helpful functions wouldn't exist
without HTML forms and CGI.
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CGI defined

CGI, or Common Gateway Interface, allows a Web server to send
data to, and receive data from, other programs. When you fill out
and submit an HTML comment form on a Web site, the data goes
to the Web server, which could pass it along to, say, an e-mailing
program, which in turn passes your message on to the owner of
the Web site, which in turn tells the Web server to tell you that
your comments have been sent. Figure 7-1 shows this process.
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Figure 7-1: CGI Makes interactivity possible.
Programs that can talk to a Web server are often called CGI
scripts. Web servers store them in special areas. UNIX servers
store CGI scripts in a special directory called the cgi-bin.
Where can I get some CGI scripts?

You can create CGI Scripts, download them, buy them, or, if
you're lucky, use or adapt those provided by your ISP. However
you get your CGI scripts, your ISP must allow them to be run on
the Web server. In some cases, that's a simple matter of the ISP
giving you access to the cgi-bin directory. In others, the ISP's
tech support staff gives you the permission you need to include
CGI scripts within the hierarchy of your Web site. Finally, to use
CGI scripts, you need to learn how to link them to your Web
pages, and build forms and other HTML-based items that connect
to the CGI scripts you want to use. We'll explore that as we move
on.
Add a counter to your Web site

When it comes to CGI scripts, perhaps the most simple and ubiquitous is the common counter,
keeping tabs on how many people have visited a Web site. Hundreds of scripts have been written to
perform this task, but the basic functionality is always the same, as are the instructions they follow:
1.
2.
3.
4.
5.

When someone visits this Web page, wake up and open the count file.
Read the number in the count file. This is the number of visitors prior to this visit.
Add 1 to the number from the count file.
Write the new number to the count file and save it.
Show the new number to the visitor.

To find out about and compare various counters, just Google the term "free Web counter." Counters
are so simple and widely available that you can put them on your Web site in a number of ways.
Some of these methods don't require anything more complex than cutting and pasting a few lines of
HTML into a Web page. In these cases, the actual CGI script is hosted on a separate server so you
needn't worry about contacting your ISP about it.

Install a CGI Script the hard way

But just to be on the safe side, let's cover how to install a CGI script on a UNIX server (the most
common type of server) the old-fashioned way.
The basic process for installing most CGI scripts (including this one) on a UNIX server (provided that
you have access to the cgi-bin) is as follows:
1.
2.
3.

Open any files that the instructions indicate require customization and make the necessary
modifications.
Upload the files to the places on the server that the installation (or README) file indicates.
Set file permissions as indicated in the script's installation instructions. File permissions are
set on UNIX servers using the chmod command. You'll often see permission expressed as a
three-digit number (755, for example). Your FTP (File Transfer Protocol) program can help
you with setting file permissions.

Setting file permissions on a Windows server requires administrative access to the server and
cannot be done through an FTP program. If your Web site is on a Windows server, talk to your
server administrator or your ISP's technical support department to get help with configuring and
installing CGI scripts.

2.

If you've done everything right, your script should work. If not, double-check everything.

Installing CGI scripts can be frustrating, but give it enough time and you'll be fine.

One of the most common errors that people make when installing CGI scripts is to upload text
data as binary data. Because of the difference between how text and binary data (such as
images) are transferred over the Internet, FTPing text data as binary will make the file unreadable
to the server. Script files, such as those that end in .pl or .cgi, should always be uploaded in text
(also known as ASCII) mode.

Everybody's talking
Counters may be useful tools and all, but it's hardly the sort of
thing to draw the masses and bring them back repeatedly to your
Web site. A much more effective way to gain and retain visitors is
by making your site the nexus for a community. People like to talk
to other people (some even prefer to do their talking through the
safety of a keyboard and monitor). If your Web site gets a good
conversation going, people will return.
A message board lets visitors engage in discussions. You've
probably visited and even chatted in a few of them, but you may
not be away that two different types of this medium exist: linear
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and threaded. Let's take a look at each.


The threaded message board: This type of message
board, shown in Figure 7-4, organizes messages in outline
form, dividing the posts into topics and subtopics, followed
by responses to the subtopics.

Figure 7-4: A threaded message board.
Threaded message boards have gone out of favor
in recent years, maybe because most people just
don't naturally think or hold conversations in such
an organized way.


The linear message board: This type of message board,
shown in 7-5, displays messages in chronological order,
making a perusal of posts feel like a natural conversation.
The drawback here is that discussions never seem to get
too in depth.
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Figure 7-5: A linear message board.
How to install a message board

We had it easy installing counter scripts -- hooking up a message
board is a bit more complicated, though some are simpler than
others. One particularly easy-to-install message board is
AnyBoard . Not only is AnyBoard free, it provides an online
installer. Simply download the Download anyboard_free.zip
script and unzip it with WinZip or some other program. In the
folder that appears, open install.txt and follow its instructions.
Feedback: guestbooks and forms

People put guestbooks on their Web sites for the same reason they set them out at weddings: it
serves no real function, but it's nice to hear from people. Unlike message boards, guestbooks don't
have usually topics. Hence, the postings aren't quite as well thought out, as the example guestbook
in Figure 7-6 demonstrates.

Figure 7-6: A guestbook.
View a larger version of this image.
The Script Archive contains not only guestbook files to download, but also complete working
instructions for implementing them on your own Web site. In addition to the three HTML files you'll
need to start a guestbook, you'll need another type of file, Guestbook.pl. The PL extension stands
for Perl, a scripting language; the nitty gritty of which is shown in Figure 7-7.

Figure 7-7: The guestbook.pl Perl script.
To set up the guestbook on your Web site, follow these steps:
1.
2.
3.
4.
5.
6.

Download all files from the Script Archive Web site.
In a word processor or Web authoring application, edit the HTML files to suit your
requirements.
Alter the Perl file to point to your Web directory, following the instructions in the README file.
Upload the HTML files to your Web site directory.
Upload the Perl file to your cgi-bin directory.
Set the file permissions as specified in the README file (using chmod ).

Once a visitor types something into the guestbook and hits the Submit button, the Perl script takes
the input and stores it in the guestbook.html file.
If you don't have the time or inclination to learn to set up or customize CGI scripts yourself, your ISP
may be able to do it for you.
Database of operations

If you're building a Web site that uses large amounts of organized
data (a business directory, for example), you should consider
using a database. A number of these helpful doo-hickeys are
available out there, ranging from the simple and cheap to the
complicated and pricey. Before we get into the particulars of using
them, let's cover some database basics.

Keep track with your
handheld

I can relate

Most Web sites use relational databases, a type of database that
organizes information by dividing it into sets that relate to one
another. For example, you decide to create a database for an
online store. The information you want to capture is:




Customer information
Product information
Order information

In a relational database, each of these types of information would
be stored in a separate table . A table stores data in a tabular
form -- like a spreadsheet. The rows in a database table are called
records and the columns are called fields.
The Customer table, then, might have the following fields:







CompanyName
ContactName
ContactTitle
Address
City
PostalCode

Each customer has a unique row, or record in the table, as shown
in Figure 7-8.
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Figure 7-8: A customer table.
View a larger version of this image.
Each customer in the Customers table might be associated with,
or related to, multiple orders in the Orders table. Each order might
contain multiple products. You could also say that products might
be associated with multiple orders. Or, in other words, more than
one customer can order any one product. At this point, you're
probably completely confused. That's why it's helpful to carefully
plan any database and use diagrams. Figure 7-9 shows a simple
diagram of our store database.

Figure 7-9: A simple diagram of our store database.
View a larger version of this image.
In this diagram, we added a table called Order Details, which
serves as a connector between products and orders. This allows
the Orders records to store information about just the order, such
as when the order was placed and where it will be shipped. A
unique piece of information called a key identifies information
from one table when it appears in another. For example, each
customer has a CustomerID, and each Order has an OrderID.
When you want to associate an order with a customer, you only
need to put the Customer's CustomerID in the order record.
Therein lies the magic of relational databases.
In the real world, database contents and relationships are far
more complicated than this simple example. Trained experts,
known as database administrators, know all the tricks and
techniques of making relational databases tick.
How are databases used on the Web?

Most Web databases are invisible to the user, but critical to the
Web site owner. Even before you scan a site for movie or
restaurant listings, you'll interact with the database that makes the
site possible. The stories and blurbs you see are stored in records
within a database and assembled behind the scenes on the Web
server to create the page you see in your browser.
From simple to complex

Adding databases to a Web site isn't easy. It's a complex and
costly process requiring a programmer or database expert who
can not only create the database, but also build the front-end
interface, the links between the database and the Web server
viewed by a site's visitor.
Don't skip this lesson on that account. With a little work, you can
give your Web site visitors access to information stored in a
database without building a full-blown database on the Web.
Many database applications have let users publish database
information on the Web through a simple Save As HTML
command.
Databases built in Microsoft Office are translated into HTML
tables easily enough the File > Export option, as shown in
Figure7-10. (It's not pretty, but it can be customized.)

Figure 7-10: Converting Access data to HTML.
View a larger version of this image.
Live data integration

Giving visitors access to your database is all well and good, but
that's not really interactive, and that's what this lesson is about,
no? To set up a database visitors can add and extract information
from, you'll need a database application
As you go database shopping, ask yourself these questions:




What's my budget for the database? Professional
database applications such as Oracle and Sybase aren't
cheap, either to purchase or to maintain. In most cases,
you'll need to hire a professional DBA (database
administrator) to manage database systems of this variety.
Fortunately, most small businesses don't need an Oraclesized solution. Microsoft Access and FileMaker Inc.'s
FileMaker Pro are both easier solutions better suited to us
mere mortals -- and cheaper, too. Both have friendly
interfaces and export easily to the Web.
Where will I run the database? To make database
content available on your Web site, the database must be
hosted on a Web server. Many business-oriented ISPs
provide the access and tools you need to make this
happen, but at a price. In some cases, access to the cgibin directory may be enough. But if you're creating a highend database, you need more direct access to the Internet



-- either via your own Web server, or through your ISP.
When you're ready to add a database to your Web site, get
your ISP to tell you how much you'll have to pay.
What platform do I want to use for the database? Since
your Web server will be hosting the database, they must
be compatible with each other, which means they must
use the same operating system. Most high-end relational
databases are available for Windows NT, UNIX, and Linux,
Access runs on modern Windows operating systems
(since Windows 95) and FileMaker comes in Windows and
Mac OS versions.

Moving on

Of all the possible uses for CGI scripts and Web forms, few have
proven so successful as e-commerce, the subject of our next
lesson. Before we explore how the Web can you convince your
Web site's visitors to part with their money, do the assignment,
take the quiz, and peruse the Message Board.

Congratulations on completing the lesson! Don't forget the following:
» Assignment:Let's get interactive
» Quiz:Lesson 7, quiz 1
» Return to the lessons list to get a quick overview of the entire class
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Assignments are designed to help you apply the information learned in the lessons.
Let's get interactive
Not to sound discouraging by any means, but most anything you want to do on your Web
site has probably already been done somewhere before. The great thing about the Web is
that everyone on it learns new tricks from everyone else. As a result, many programmers
openly share their work with other programmers for no charge. Once you've tackled the
basics of installing CGI scripts, there's no end to what you can accomplish.
Your assignment is to visit Script Search and browse through the Perl scripts. If you're
using a Windows server, browse the ASP scripts. Find some free scripts that sound
interesting, download them, and try installing them on your Web site. Be sure to read the
instructions carefully.
If you get stuck, don't be afraid to seek out help on the Message Board or elsewhere on
the Web. Programmers are by and large a friendly and helpful bunch and don't mind
helping others, especially if it gives them a chance to talk ad nauseum about computers.
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Quiz: Lesson 7, quiz 1
Quizzes are designed to give you a chance to test your knowledge.

1. What two things make interactivity possible on the Web?
A.

E-mail and message boards

B.

A modem connection and lots of coffee

C.

Forms and CGI

2. What's Perl?
A.

One of those grunge bands from Seattle

B.

A programming language
A hilarious new sitcom about a brassy mother of three dealing with life in today's
mixed up world

C.

3. True or false: Linear Message boards organize messages by topic.
A.

True

B.

False

4. True or false: Counter scripts typically use relational databases and installing one requires
the services of a database consultant.
A.

True

B.

False
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Web site basics
» Lessons
» Message board
» Class materials

Welcome to your lessons. Some lessons may have quizzes or
assignments for additional learning. Don't forget to join your fellow
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E-commerce, the buying and selling of things online, has turned into a regular part of the business
world. Small and large businesses alike have brought capitalism to the Web, and they won't be
leaving any time soon. In this lesson, you'll learn how to get your piece of the pie.
Types of e-commerce

E-commerce comes in three flavors:




B2C (Business to Consumer): Web sites set up by a business to sell products directly to
consumers, like Powell's City of Books in Figure 8-1.
B2B (Business to Business): Web sites built by a business to sell goods to another
business. Dell's site has a B2B area alongside its a B2C section.
C2C (Consumer to Consumer): Web sites in which consumers sell to other consumers, like
eBay and Amazon Marketplace . The C2C Web site itself is typically a business that makes
money off commissions or listing fees.

Figure 8-1: Powells.com is a B2C Web site.
View a larger version of this image.
We'll be focusing on B2C (and a little B2B for good measure).
Your e-commerce plan

Before taking your Web site into the land of e-commerce, consider the following:








What you're going to sell: If you own a small business, you know this already. If not, think of
something. Remember that the same market forces of the brick-and-mortar world apply to the
Web. Do some research to find out what sells.
Know your competition: While you're researching the market, take a look at your
competitors. Can you beat an established online retailer like Powells at its own game? You
might if you can figure out a particular niche, or a way to offer better prices or speedier
delivery. Whatever you do, make sure you have an edge.
Get access to the products you want to sell: If you don't already have a business, you may
not know where to get the products you want to sell at wholesale prices. You can track down
several manufacturers and distributors at Thomas Register .
Promote your Web site: Real-world retail has the Web licked when it comes to foot traffic,
a.k.a. walk-ins . Human beings are much more likely to wander into a store than a Web site.
No one will come to your store unless they know about it through the promotion techniques
covered in Lesson 6.

These Web sites cover e-commerce -- perfect for boning up on the industry:



E-Commerce Times
E-Commerce News from Internet.com



Business 2.0's E-Commerce News

Online selling strategies
You won't succeed selling online unless you treat your ecommerce Web site as you would a shop on Main Street. Many of
the same methods behind running a real-world store apply -- in
translated form -- online.

Space-saving flexibility

Present your products

Unless you already have all of your product data in a database,
you may want to only sell a subset of your product line on the
Web. Otherwise, you'll be in store for a lot of typing. Figure out
which of your wares would sell best online.
Once you've figured that out, photograph the goods. Potential
customers want to see what they're buying, especially when
ordering online. A digital camera will come in handy here, but be
sure to take the time to set up the lighting and layout for the photo
so it looks as professional as possible. Or just hire a
photographer.
The customer is always right

Like we covered in Lesson 6, you'll never go wrong with good
customer service. That's especially true when it comes to ecommerce, where other, more responsive Web sites are mere
clicks away.
A few customer service essentials to remember:






E-mail communication: You should set up your Web site
to generate a confirmation e-mail for each order placed.
This lets the customers know the order has been received
and is being processed. Subsequent e-mails should let
them know when their order has shipped, when to expect
it, and how to track the package online. When you first
start out, you can send these e-mails yourself. But, as
business picks up, setting up a program to do it
automatically will ease your life considerably.
Help and/or FAQ pages: Include an obvious link to a Help
or FAQ (Frequently Asked Questions) page, or both.
These should contain instructions for using every aspect of
your online store and contact information (preferably both
e-mail and phone number, if you can provide phone
support).
Shipping options: Give your customers as many shipping
options as possible to suit their needs and budgets. Major
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shippers will discount shipment fees for businesses that
send a lot of volume, and you can pass these savings on
to your customer.
Save room to ramp up: Be prepared for sudden changes,
such as a rapid increase in Web site traffic and sales. Also
have a plan for hiring extra warehouse workers and
shipping clerks, even temporarily, as business demands.
And last but not least, choose an ISP with the technical
resources to grow with you from the get-go.

Your Web site has the potential to be seen by the world, so
consider how to handle International orders. Some U.S.
retailers limit online sales to North America, a logical
approach, but one that can prove limiting. You may find
participating in the global economy worth the extra effort.

The miracle of shopping carts

Before you can see anything on your Web site, you'll need shopping cart software for your potential
shoppers.
As in the real world, online shopping carts let customers store products they've chosen until they're
ready to complete the transaction. They also make it easy to set the quantity of items to be
purchased and handle calculating the shipping charges and tax, as well as payment verification.
Step-by-step shopping

Here's how a shopping cart works:
1.

The customer visits a Web site, searches or browses for products, and views a page
displaying a product in detail. In Figure 8-2, Powells.com is selling a book. Notice the Add to
Cart button below the price listed in the box next to the picture of the product.

Figure 8-2: A typical e-commerce product Web page: Powells.com.
View a larger version of this image.
2.

3.

After the shopper adds the product to his cart, a summary page appears, as shown in Figure
8-3. Here the shopper can change quantities or delete one or more items. Once the shopper
moves to the checkout section of the Web site, the transaction activity takes place. The
shopper enters contact information and that all-important method of payment. At each step in
the process, the shopper can cancel the order or buy later.
Finally, the order is completed. Most retailers send e-mail confirmation of the order, as well as
customer service information in case something goes wrong.

Figure 8-3: The shopping cart on Powells.com.
View a larger version of this image.
Let your software do the selling

Does e-commerce suddenly sound daunting? It won't once you get a decent e-commerce software
package. These applications install right on your Web server and, through a lot of complex, databasedriven number crunching, create instant stores on your Web site that automate the selling process.
Any e-commerce software you consider should:







Keep a database of products you can update.
Determine whether a selected item is available. If it is, the software should let customers
proceed with their orders. If it isn't, the shopper should be notified the item is backordered and
given the option to cancel.
Keep track of the items in a cart and the resulting subtotals.
Communicate with the product database. When a customer chooses a product, its information
should be transferred from the database to the customer's shopping cart.
Notify the store owner and send a receipt to the customer after an order is placed and
payment has been received.

Just a few of the available e-commerce software packages include:


iHTML Merchant







Shopzone (offers both standalone software and store hosting)
Mercantec
AbleCommerce
MonsterCommerce
iNetStore

All that stuff I said about choosing your ISP carefully in Lesson 4 still applies when it comes to ecommerce. Many ISPs offer e-commerce packages that they'll run for you off their servers. Though
more convenient and less expensive than creating your own e-commerce set-up, letting an ISP
handle your e-commerce gives you no say in which e-commerce software your Web site can use.
Then again, considering the technical support an ISP would provide for this added functionality, the
tradeoff could be worth it.

Most ISPs offer some sort of e-commerce capability. Shop around to find the best price and the
implementation that is most suited to the type and volume of product you plan to sell.

Getting paid
While you're going to so much effort to take care of your customer, don't forget to look out for number
one. Selling through the Internet means receiving payment through the Internet, and that involves a
bit of slightly tricky programming. Don't be daunted though, it's not too difficult to set up.
Processing plastic

Credit cards have become the easiest and most commons means of taking payments online. They
require two main ingredients to work on a Web site:




Software that authorizes transactions: ISPs that offer e-commerce packages can
processes credit card information as easily as those little boxes with the card slots in stores
that send it over phone wires. If you're handling your own e-commerce independent of an ISP,
try a credit-card processing service such as WorldPay and Authorize.Net .
An online merchant account: Along with processing and fraud check, the e-commerce
packages of most ISPs include a merchant account. If you're handling your own e-commerce,
look into companies such as GlobalMerchant , 1stCommerce , and Charge.com provide
online. Shop around and get recommendation before committing.

If your company is already established and takes credit cards, you need to find out whether your
bank or third-party processing company (companies that are not banks, but get you set up with a
bank and do the processing for you) is Web-ready.

Accepting checks

Some customers don't like to use credit cards online, so you should offer them the option of paying
by check. PayByCheck.com provides nifty check processing functionality that can be incorporated
into your Web site. For a small setup fee and per-check charge, the service lets you take digital
checks without any special hardware or software. All that shoppers have to do is enter the information

from one of their checks into a form on your Web site that links to PayByCheck, which handles all the
rest.
Digital cash

A third type of payment, digital cash , involves services in which a person creates an account with a
service, puts money into that account, and then authorizes a certain amount to be transferred to a
Web site electronically. PayPal dominates this market. To receive PayPal payments, you need
merely to set up an account with the service and tell your customers you accept it as a valid payment
option.

PayPal is often used in C2C e-commerce.

POs and CODs

B2B e-commerce Web sites sometimes use POs (purchase orders). This means that you ship the
goods and bill your customers, and they pay you within a certain amount of time (Net 30, for
example). This works well if the company you're dealing with is a large, established business or a
company that you have done business with before.
And then there's always the time-honored COD (cash on delivery). You can set this up easily enough
with most major shippers. It works like this:
1.
2.
3.

You ship the goods.
They deliver the goods and collect payment at the time of delivery.
The check is then sent to you, usually overnight.

There is, of course, a fee for handling COD transactions.
Store in a box
One way to simplify the set-up of an e-commerce Web site and
save money is to outsource to a Web-based e-commerce service.
Your store essentially becomes a part of a larger e-commerce site
while retaining its own identity and look.
Yahoo! Stores exemplifies this store in a box concept. For a flat
hosting fee, a small per item fee, and a small transaction fee, the
Yahoo! servers will host your online store, providing a shopping
cart, secure credit card transaction processing, an order tracking
system, and include Web site traffic analysis tools to boot. It even
helps you get a merchant account. As an added bonus, the
service lists your products alongside those of other Yahoo! Stores
Web sites at Yahoo! Shopping , giving you a built-in audience.
However, there are disadvantages:

Simple, economical,
portable
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Limited control over Web site layout: You can design
your own Web site using the service's online layout tools,
but you're limited to one of a few layout designs. Color and
font choices are typically quite broad, however, and you
can use your own logo and other custom graphics.
It's not at your regular Web site: Because your ecommerce Web site is a part of a larger e-commerce site,
it will have a URL like http://store.yahoo.com/yourstore.
If you have an existing Web site, visitors will have to leave
your site to shop. Most services will host your domain
name for an additional fee, so you can move your entire
site over to the service if it's feasible. This works best if
your entire site is devoted to e-commerce. Another option
is to link product listings on your current Web site to the
new e-commerce site.

Weigh your options

Consider these points when choosing a service to outsource your
e-commerce Web site:










Price: Most services are quite affordable.
Free trial: Use the free trial period to determine if the
service is for you.
24/7 tech support: When you have a problem you want it
resolved within hours, not days.
References: Find out who else is using this service and
contact them to find out how happy they are with the
service.
Tax calculation: As with catalog purchases, an ecommerce store must have a physical location in the same
state as a customer for tax to be charged. But this may
change, so stay aware. The service should be capable of
calculating tax if needed.
Order management: You should be able to view and
manage orders online and download order info as needed.
Shipping and handling fees: Many merchants calculate
shipping charges based on the weight and/or destination of
an order. The service you use should be able to calculate
shipping charges based on these or other variables you
want to accommodate. It should also be able to use one or
more popular shippers' actual rate tables.

Besides Yahoo! Stores, some other Web-based e-commerce
outsourcing services include:





MerchandiZer.com
BigStep Store
ShoppingCartsPlus.com
CityMax.com

times as fast as 39 seconds-and you can even store up
to 4,000 photos on the 4GB
hard drive!

Moving on

In this course, you've learned to design an effective Web site, use
a WYSIWYG or HTML Web authoring tool to develop it, find an
appropriate ISP to host it, use multimedia and interactivity to spice
it up, effectively promote your site, and set up an online store.
Congrats. Even if you don't have a Web site up and running yet,
pat yourself on the back anyway. You've earned it.
One way to do well on the Web is to stay informed about the
industry. To that end, here's a list of Web sites to keep up with
your reading:










The Industry Standard
Internet World
InternetWeek
TechWeb.com
E-Commerce Times
ZDNet
E-Commerce Guide from Internet.com
CNET News.com
Wired Magazine News

But before you go -- and this is the last time I'll have to say this -take a look at the assignment and the Message Board. I'll let you
off easy by omitting the quiz for this lesson. Good luck with your
Web site!

Congratulations on completing the lesson! Don't forget the following:
» Assignment:E-commerce for everybody
» Return to the lessons list to get a quick overview of the entire class
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Assignments are designed to help you apply the information learned in the lessons.
E-commerce for everybody
Decide whether your particular Web project calls for e-commerce. If you're a business
selling a product, the answer is probably yes. Remember that even nonprofit Web sites
need e-commerce tools (such as shopping carts, credit card capabilities, and secure
server) to sell a host of wares promoting the cause (T-shirts, bumper stickers, and
publications) as well as to collect donations.
If you're planning on implementing e-commerce, do some research on your own and find
an ISP that provides great service, e-commerce, and credit card processing services.
Check its references and get its prices. Share your research with the class.
If you're so inclined, sign up for a free trial at Yahoo! Stores and try setting up a store.
What do you think about this store-in-a-box service? Share your experience and opinions
with the class in the Message Board.
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